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Overview

This workshop gives the users the ability to use the Bentley Civil Roundabouts application in a hands-on
environment.

The Roundabout tool is a rules-based approach that allows intelligence to be preserved in the design,
standards to be applied to the roundabout design, and dynamic adjustment to the design.
Prerequisites

= Fluent in MicroStation and a basic understanding of roundabouts is recommended.
= Previous GEOPAK and Roadway Designer classes are recommended.

Objectives

After completing this course, you will be able to:

= Have a basic understanding of the rules based approach as it pertains to design
= Understand the concepts to manipulate your design and save your alternatives
= Understand new Civil Geometry Tools and GEOPAK Site tools

= Manipulate the template to fit your needs
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Defining Physical Features

A roundabout is a type of circular intersection, but not all circular intersections can
be classified as roundabouts. In fact, there are at least three distinct types of circular
Intersections:

= Rotaries are old-style circular intersections common to the United States prior

to the 1960’s. Rotaries are characterized by a large diameter, often in excess of
100 m (300 ft). This large diameter typically results in travel speeds within the
circulatory roadway that exceed 50 km/h (30 mph). They typically provide little or
no horizontal deflection of the paths of through traffic and may even operate
according to the traditional “yield-to-the-right” rule, i.e., circulating traffic yields
to entering traffic.

= Neighborhood traffic circles are typically built at the intersections of local streets

for reasons of traffic calming and/or aesthetics. The intersection approaches

may be uncontrolled or stop-controlled. They do not typically include raised
channelization to guide the approaching driver onto the circulatory roadway. At
some traffic circles, left-turning movements are allowed to occur to the left of
(clockwise around) the central island, potentially conflicting with other circulating
traffic.

= Roundabouts are circular intersections with specific design and traffic control

features. These features include yield control of all entering traffic, channelized
approaches, and appropriate geometric curvature to ensure that travel speeds

on the circulatory roadway are typically less than 50 km/h (30 mph). Thus, roundabouts
are a subset of a wide range of circular intersection forms.

To more clearly identify the defining characteristics of a roundabout, consistent
definitions for each of the key features, dimensions, and terms are used throughout
this guide. Exhibit 1-1 is a drawing of a typical roundabout, annotated to identify

the key features. Exhibit 1-2 provides a description of each of the key features.
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Description of Key roundabout features

Counterclockwise
circulation

---------

Splitter island
Apron
Accessible
pedestrian
crossing

Figure 1 Drawing of key roundabout features

Feature
Central island

Splitter island

Circulatory roadway

Bicycle treatment

Yield line

Description
The central island is the raised area in the center
of a roundabout around which traffic circulates.

A splitter island is a raised or painted area on an
approach used to separate entering from exiting
traffic, deflect and slow entering traffic, and
provide storage space for pedestrians crossing the
road in two stages.

The circulatory roadway is the curved path used
by vehicles to travel in a counter- clockwise
fashion around the central island
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Apron If required on smaller roundabouts to
accommodate the wheel tracking of large
vehicles, an apron is the mountable portion of the
central island adjacent to the circulatory roadway.

Yield line Avyield line is a pavement marking used to mark
the point of entry from an approach into the
circulatory roadway and is generally marked along
the inscribed circle. Entering vehicles must yield
to any circulating traffic coming from the left
before crossing this line into the circulatory
roadway.

Accessible pedestrian crossings Accessible pedestrian crossings should be
provided at all roundabouts. The crossing
location is set back from the yield line, and the
splitter island is cut to allow pedestrians,
wheelchairs, strollers, and bicycles to pass
through.

Bicycle treatments Bicycle treatments at roundabouts provide
bicyclists the option of traveling through the
roundabout either as a vehicle or as a pedestrian,
depending on the bicyclist’s level of comfort.

Landscaping buffer Landscaping buffers are provided at most
roundabouts to separate vehicular and
pedestrian traffic and to encourage pedestrians
to cross only at the designated crossing locations.
Landscaping buffers can also significantly
improve the aesthet-ics of the intersection.
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Circulatory
roadway width

Entry radius

v BN

Roundabouts: An information Guide — FHWA-RD-00-67, June 2000
http://www.tfhrc.gov/safety/00068.htm

Dimension

Inscribed circle diameter

Circulatory roadway width

Approach width

Departure width

Entry width

Description

The inscribed circle diameter is the basic parameter used
to define the size of a round- about. It is measured
between the outer edges of the circulatory roadway.

The circulatory roadway width defines the roadway width
for vehicle circulation around the central island. It is
measured as the width between the outer edge of this
roadway and the central island. It does not include the
width of any mountable apron, which is defined to be part
of the central island.

The approach width is the width of the roadway used by
approaching traffic upstream of any changes in width
associated with the roundabout. The approach width is
typically no more than half of the total width of the
roadway.

The departure width is the width of the roadway used by
departing traffic downstream of any changes in width
associated with the roundabout. The departure width is
typically less than or equal to half of the total width of the
roadway

The entry width defines the width of the entry where it
meets the inscribed circle. It is measured perpendicularly
from the right edge of the entry to the intersection point
of the left edge line and the inscribed circle.




[ROUNDABOUT WORKSHOP]

Exit width The exit width defines the width of the exit where it meets
the inscribed circle. It is measured perpendicularly from
the right edge of the exit to the intersection point of the
left edge line and the inscribed circle.

Entry radius The entry radius is the minimum radius of curvature of
the outside curb at the entry.

Exit radius The exit radius is the minimum radius of curvature of the
outside curb at the exit.
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Chapter-1 Libraries

Creating a Roundabout Library

As discussed earlier Bentley Civil Roundabouts (BCR) uses a library roundabout that is a preset
configuration of the roundabout (RAB). A special toolset is available for setting up the RAB.

Before beginning, the user should familiarize themselves with the various parts of the RAB. The prior
section outlined the description of these parts as defined by FWHA’s manual on roundabout design.
When working with BCR you will find this same terminology. Additionally BCR expands on this
terminology in order to assign properties to other geometric constraints needed for roundabout design.
Below is a list of additional terminology:

Circulatory Crown- Describes the location of crown element if desired in the circulatory area.
Overrun (Apron) - area allowed for overrun in turning radius of circulatory area.

Approach- Consists of the group of geometric features that make up the approaching lane to the RAB.
Deflection Area- The theoretical area used entry and exit to the RAB circulatory area.

Flare- Collection of geometric elements along the outer lane of the RAB used to join adjacent
approaches.

The exercise below will guide the user through customizing a delivered library RAB. The customization
will involve:

e Selecting a closely related RAB template
e Redefine the geometric components associated to the RAB

e Featurize the geometric components

NOTE: The current version of ProjectWise does not work with Roundabout Libraries. The
examples in this manual assume the project is not in ProjectWise, however, it is important
that the drawings are placed in ProjectWise when complete.




_ [ROUNDABOUT WORKSHOP]

Set Up Roundabout Library

1. Open the File RAB-MODOT.dgn C:\Data\CH-1Create Library. (file cannot currently reside in
ProjectWise)

2. Open the toolbox “Roundabouts- Library Browser” ... Tools > Roundabouts>Roundabout Library
Browser or from the task menu

€ Roundabouts M= A

(e

3. From the RAB Library toolbox, select the Add Library Icon.
Roundabout Library Browser X

Ellx 1% == (@8] @

[#- | Example Right Hand Drive US Style Survey Foot Roundabout.dgn

® Bxample Right Hand Drive US Style Intemational Foot Roundabout dgn
= Example Right Hand Drive ltalian Style Roundabouts Library dan

® Bxample Right Hand Drive French Style Roundabouts Library.dgn

- Example Right Hand Drive Danish Style Roundabouts Library.dgn

[#- | Example Left Hand Drive English Style Roundabouts Library.dgn

#- | Example Left Hand Drive Australian Style Roundabouts Library.dgn

4. Select the RAB North America.dgn. C:\Data\Roundabouts/i\CH-1Create Library

Note An RAB North America,dgn will now appear in the Roundabout Library Browser

5. Open the RAB North America Roundabout.

@ | Example Left Hand Drive Australian Style Roundabouts Library dgn
B- RAB North America.dgn
= # RA_
= Approachl
-2 Approach2
= Approach3 J
= Approachd -

m

6. Select RA _.
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Roundabout Library Browser

+ % @E{ :::; ®|_=—[| -,'3)

Example Right Hand Drive US Style Survey Foot Roundabout.dgn

Examp| Place Roundabout | Style Intemational Foot Roundabout.dgn

ght Hand falian Style Roundabouts Library.dgn

Example Right Hand Drive French Style Roundabouts Library.dgn
Example Right Hand Drive Danish Style Roundabouts Library.dgn
Example Left Hand Drive English Style Roundabouts Library.dgn
Example Left Hand Drive Australian Style Roundabouts Library dgn
RAE North Amesica.dgn

-3 RA

-

(1] -+

7. Setup the RAB properties.

Roundabout AL
L [ Name RA_ \

Roundabout Type European Style

Circulatory Area ~

Over Run Visible Yes .

Circulatory Crown Visible No

Subsidiary Crown Visible No

B Center Point [] 5.7464.19.7334 L

Transition Offset Rule ~

Circulatory Crown Offset 13.0000 .

Subsidiary Crown Offset 6.5000

Circulatory Width 26.0000

Over Run Width 4.0000

Arc Rule A |

Radius 120.0000 | =

8. Click the Place Roundabout Tool.

Roundabout Library Browser
| x =% (@]
¥ | Example Right Hand Drive US ¢

+ Exm Place Roundabout | €
+ Examole Fichl Hand Drive &

This will place the RAB based on 1 or more legs of the Roundabout. If you select only 1 leg, you will have
a roundabout with a single approach created, based on the settings for the approach. An approach will
be created for each leg selected. Follow the prompts and select the center point and a RAB will be
created. Below a Roundabout has been created selecting 4 legs.
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The Library RAB contains the

This RAB can be modified by altering

| any of the features to include

\/ additional approaches, customize
lanes, circulatory area, and geometry
modifications.

Modify Circulatory Area

4] geometric design for a typical RAB.

9. Change the diameter of the RAB circulatory area by selecting any portion of the circulatory area.
Change the diameter to 150’. You will see selecting the radius will pull up the Heads Up Display.

Note Make the above modification done using the On screen Editing (Heads Up Display)
Use the MicroStation Element Information tool to change the following:

10. Select the circulatory area.

0,

11. Open the Microstation Element Information dialog

10
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Under the Circulatory Area — Transition Offset Rule, set the following values:

(i) Element Information =

= Kk <Selection>

=4
@1 Arc: 609-20.
#--1_ Arc: Entranci
@~ Arc: EOPBEx
#--4_ Arc: Entranc

Circulatory Area

Transition Offset Rule

Circulatory Crown Offset  14.0000
Subsidiary Crown Offset  6.0000
Circulatory Width 24.0000

Il Over Run Width 4.0000

Arc Rule

Modify Approaches

12.
6)

Select the right approach.

Element Information =L —

Take time to review the
Information available for the
different features that make up

the Roundabout

»

R <Selection>

=t [
@2 Complex Element: Road Centedined
[#)-== Median

m

(=== Entry Lanes
f-== Lane 1 ~

Approach ~
Name .
Type Parallel Side Triangle
Create Island Yes
Roadway Type Dual
Approach Length Tyr Length
Approach Length 500.0000
Offset No
Transition Offset Rule A~
Median Width 2.0000
Median Width 2.0000

H xE-ax N .

13. Expand the Approach in the element information dialog, expand “Entry Lanes”

14. Highlight Lanel.
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15. Set the Lane width to 12’.

r N
() Element Information LELM
== Approach A
f-& Complex Blement: Road Centerfiny—
[#-== Median i |
=-== Entry Lanes
w = B =
T — s
Transition Offset Rule ~
\Width 12.0000

16. Add additional lanes. Set the Number of Entry Lanes to 2.

() Element Information = =

= & <Selection>
El-==% Approach
+-S Complex Blement: Road Centedine 1
+-== Median
2R ad ENiry Lanes
[#-== Bdt Lanes
}-[B> Deflection Area

3
-~ Hare

Lanes ~
Number OF Lan@
‘."fld-ening_

17. Repeat the process for the Exit Lanes, creating 2-12” wide lanes.
Experiment with 3 or more lanes.

18. From the Task Menu open the Message Center to view information on the new message alerts. Tools
> Civil Geometry > Message Center.

Civil Message Center
Hide All ‘“ 50 MicroStation ; €& 0 Errors ‘ ‘_:30 Warnings l !02 Messages

Blement Message  Description

OO'eale Flare  Geomet... Exit width needs to be greater than or equal to the total lane width.
aCreate Flare  Geomet... Entrance width needs to be greater than or equal to the total lane width.
i Disolav

19. Select the entrance “Flare” and zoom to the intersection as shown below. Modify the theoretical
lane width to be equal to the combined 2 lane width (12’). Repeat this on the exit lane.

12
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FLARE

Theoretical Lane Width
(TLW)

Properly constructed
geometry of the
mﬁ entrance of the

2| roundabout will

'r'!-.-..,_ —— serve to calm traffic
- .
. e entering the
1 ""-.--‘. =
'~ )
. e
“‘
-~

TLW Dimension circulatory area.

Note The user will also need to modify the exit lane by selecting the exit flare and editing in
the same manner as the entry. Once edited the alerts 9 will disappear.

20. Modify the length of the right approach by selecting the approach. Change the “Approach Length
Type” in the element information dialog to “Length” this will add an Approach Length field to the
information dialog. Enter 600’ for the length.

13
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(i) Element Information Lil_g

=k <Selection>

Yo prosch

Transition Offset Rule ~

Median Width -0.8202
Median Width 0.8202

Approach ~
Name

Type Parallel Side Trian
Create Island Yes

Roadway Type Dual

Approach Length Type Length
500.0000

Offset No

21. Last- Modify the central median Width to 2’ by selecting the center of the approach and use the
Heads Up Display enter 2’ for both the entry reserve and exit reserve.

O@UdB00

E‘f‘._

i)

-2.0p)
— -
Q

Modify Remaining approaches

22. Modify the “Left” approach using the Replace Approach command. THIS TOOL IS LOCATED UNDER
TOOLS>ROUNDABOUTS, OR IN THE TASK MENU FOR ROUNDABOUTS. THIS IS NOT THE TOOL LOCATED

IN THE ROUNDABOUTS LIBRARY.

"; ' Replace Approach

14
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Approach To

R
Copy I
4 f i 3
Select Approach T:-ﬁe:-ra;.'e_'_ o /—_
Approach | Line N - /

Level: Default &

Approach To
o Replace

23. Modify the Upper and lower approaches as follows.
a. Change the approach length to 400’.
b. Change the Entry and Exit Lane width to 12’.

24. Save and Close your drawing file.
Linking Features Database

Prior to assigning features make sure the Design and Computation Manager has the
“Modot_english.ddb” as the items database.

e Activate GEOPAK

e Open Design and Computations Manager

15
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A Design and Computation Manager =4
File Edit Settings Favorites Help

g id B¢ N &
@ t\gpk_std\déc_manager\modot_english.ddb |

| = |

(2 Drafting Standards - COGO

(> Payitems

(2> Drainage
> Ditch

" @ 208-10.00 Interception Ditch - 4'
@ 208-10.00 Interception Ditch - &'
(& 208-10.00 Interception Ditch - 8'
A 208-10.00 Interception Ditch - 10'
@ 609-10.60 Paved Ditch - 4'
A 609-10.60 Paved Dach - &
A 609-10.60 Paved Ditch - &
A 609-10.60 Paved Ditch - 10°
A 609-40.10 Drain Basin -

f"@
b

»

(L

&

Open the Items Browser on the Primary Tool Bar.

[ % nems ESHE )
s QiEeadm s
ES Design Standards v
E- Content Management -
&) Content Management ' Once imported features with
2 : > Link Active DDB Features annotation properties can be set
i New Category to auto annotate. Features used in
W Cont New Feature Definition ~ » ") Hz geometry (IE alignments) can
dbvace be set for geometry to persists or
store in the native Coordinate
Geometry database. These
attributes are set using the Details
panel, accessed through the Item
E= Civil Selection ~ Browser.
EE Geometry v
M) Active v

The user can assign features to each element comprising the roundabout. Using the now linked DDB,
you can assign features to control symbology and assist in quantities calculations.

16
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Assigning Features to the RAB
1. Select outer lane of any of the RAB approaches and open element information.
2. Expand the Lane down to the “complex element”.

3. Use the Feature section, tag the feature Definition field to expose the list of active features.

4. Select an edge of pavement feature to apply to the outer lane edge.

(@) Element Information = _
=- Kk <Selection>
-== Lane
Sl Complex Element: EOPNew
/ Line
General ~
Description Complex Hement: EOPN
Level Roadway-Edge of paver
Color o
Line Style EHo
Weight = 2
Class Primary
Number of elements 1 R : e )
i i Assigning features in the
library is much more efficient
Geometry v )
as the features will be
fsatuze o automatically passed into the
Feature Name EOPNew . .
o RA sign pr :
Feature Definition  EOP New B design project

5. Repeat this process to the various geometric components as time permits.

A completed RAB library will be used in the subsequent sections based off the workflow used in this
chapter.

17
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Chapter-2 Working With Civil Geometry

Project Overview

The design is a proposed Entrance and Exit ramps along an existing Interstate Hwy.
Roundabouts have been planned to complete the intersection and to quickly move the traffic
through the top of the ramps.

The project will consist of two-on off ramp exchanges, each with its own roundabout.
Additionally the Hwy overpass will require a bridge and an extension of the SR Rt 63. This
workshop does not address the compliance of the roadways with all AASHTO standards, nor is it
intended to serve in any design aspect. It does attempt to create a realistic design situation and
expose the user to a workflow combining Roundabouts, Civil Geometry, GEOPAK Site and

Roadway Designer.

18
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Working with Alignments

As shown in the Diagram the designer will need to create a new alignment for the proposed road
and modify the existing road to accommodate the RAB.
The Roundabout tool will work with graphics created from MicroStation, civil application
GEOPAK or Bentley Civil Geometry. This workshop will use a combination of stored
alignments and alignments created using civil platform geometry. The workflow will consist of
the following:

e Import Stored alignments representing “best fit” existing roadway alignments

e Create a new Alignment on the south west side of the main route

e Modify an existing alignment of the road intersecting to the NE of the main route

Bentley Civil tools can be located from the Task Ng}@gg@_i_gn_rp_qu | (shown below). Tools>Tasks

B L it -

s | Tools | Utilities Workspace Window Desigi
Diiv ..__.../ Attributes E]
Primary
Y 7677 Standard
v Main
Main - MoDOT
Tasks

Animation »

<. Civil Geometry L

Q& 1 & @ ¢

B AN .
Tasks w ’ N OO 8

BEZy e 820D
| 5-€ Roundabout — P —

A Data Acquisttion T _;_:,_ e

i~ K MoDOT Classic )

+-  Drawing A \f’J ;f :

+-(d Drawing Composition

- -

Additional Tools used with the new Civil Geometry toolset include the message center, Item
Browser and the Feature toolbar.

Note  When using Civil Geometry, alignments may reside in a reference file.
19
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Import Existing Geometry

1. Open the file Geometry _Training.dgn C:\Data\ J9I2184. (file cannot currently reside in

ProjectWise)

The drawing will open with the geometry that makes up the ramps and mainline locations along

with the background images to show overall location.

2. Locate the Civil Geometry Task bar shown on previous page.

3. Tag the Import Geometry command R‘ -.

Note  For The initial import Projectwise Integration can be used to Navigate to
the GPK Located on PW CH2 folder- For subsequent Chapters in the
workshop the COGO Preferences will need to be reset to point to the

appropriate COGO folder

4. Set the Design and Computation Manager to MoDOT Existing Base Line, Place

Influence.

File Edit Settings Favorites Help

g id | &

“ Design and Computation Manager s

Cl=Eh )

@ t\gpk_std\d&c_manager\modot_english.ddb
(3 Design Standards
(> Drafting Standards - COGO
2 Location Survey
£ Miscellaneous
(> Plan
(> Alignments
MoDOT Bxisting Baseline
MoDOT Proposed Baseline
&y MoDOT Temporary Baseline
3 Profile
SO RW
€2 Payitems
3 3PC Tools

5. Select the GPK. Job218.gpk

|| # MoDOT Existing Baseline

.....................................

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

Match Point Text

Draw Plan & Profile

M lmmsmrw-img i

ol [ L

(F.1. 3 (R Y 912184
L. Name
e |, projdbs
Recent Places ' rddbs

- 6. job184.gpk
5 job218.gpk

- 1
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6. Toggle the Rampl, Ramp2, Ramp 3, Ramp 4 and RTE6G3 alignments.

SR C:\DATA\I9I2184\J0B218 GPK]

@[ |Curves

@[] PointList

=-{V] Alignment

=-{¥] NoFeature

- [V|RAMP1
.. RAMP2
- [VIRAMP3

..[V|RAMP4
..[V]RTE63

7. Click import from the dialog. This will draw the baseline information into the drawing
file along with the correct symbology.
8. Save the drawing file.

21
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Create Hz Alignment using Civil Geometry Tools

With the existing Geometry in place the designer can begin creating new geometric alignments.
Civil Geometry Tools.

9. Open the Design and Computations Manager and place influence on MoDOT Proposed
Baseline.

M Design and Computation Manager =
~ File Edit Settings Favorites Help ) _
e id’ & =@ % [ = 7] Adhoc Mtibutes | Maich Pont Ted |
] NewBementOnly |  Draw Plan&Profie |

@ t\gpk_std\d&c_manager\modot_english.ddb

(23 Design Standards

. s

10. Locate and open the Civil Geometry Task menu.

22
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11. Zoom to the intersection of the new outer road and Rte 63 south.

13. Begin with Outer Road start point where it intersects Rte 63 and click a start point shown
above.

23
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14. Follow the outer road to the west and click the next tangent point

15. Click on the Arc Between Points.

Arc Between Points
Arc To Element

Arc From Element
Complex Arcs Between Elements - Task 4
Arc Between Arcs

[T S TPVRR T [T

- Open as ToolBox

24
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16. Set the dialog Placement Method to Start\End\Pass-thru.

" © Arc Between Points l=l8] = |
| ProoomentMotol  [SaVEnd\Posiim =
G Start\Radius
ST Center Radius
Start Direction

 |StartiPass-thru\End
Start Tangent Direction | Start Direction\End

End Tangent Direction Loaricnd Direction
Sweep Angle 180°

Arc Length 4737764

Hand Clockwise =

Construct the curve using the start point on the 1.east, the 2.end point on the 3. west using the
nearest snap as a thru point as shown below.

17. Using the above methods, complete the rest of the chain.

Note  Use the keyboard arrow keys to change the heads up display
options if needed.

25
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18. Select One of the Arcs created using the Civil Geometry Tools. You will notice
that the dimensions show up and can be edited on the heads up display. It also
displays where and what type of snap was used to create the arc.

19.Remove your selection and zoom out to where you can see the new alignment for
the Outer Road.

20. Open the Items Browser and check that under Content Management, we are
linked to the modot_english.ddb file. If not, we need to right click on Content
Management Model and Link Database.

i : —
s Qa8
EE Design Standards v

E: Content Management -~

N e
=, = modot_english.ddb

3PC Tools

Design Standards

Drafting Standards - COGO
Payitems

[+

26
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21.Click on the Complex by Element tool ff in the Civil Geometry Toolbar.
22.Set the method to Manual and Choose the Feature Definition. Set the Feature to
“Drafting Standards - COGO>Plan>Alignments>MoDOT-Copy1” and change the

Name Prefix to MoDOT-Proposed.

Feature

Use Feature

Feature Definition MoDOT -Copyl [+

Name Prefix

MoDOT-Proposed

Maximum Gap 0.0328

Feature

Use Feature
Feature Definition _MTDEJ_'ITCO:?I_E

@-{Z Location Survey
2@ Pen
. &=-{Z2 Aignments

23. Select the east most tangent, be sure the direction of the chain (arrow) points left

(west).

27
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24. Select each remaining element in sequence — DP after all elements have been
selected.

25.0nce complete, use the element selection tool to highlight your newly created
complex element.

28
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Create the Edges of Pavement and Shoulder Using Civil Geometry

2 Civil Geome... 12 = = A
Q7 %@
W_ 3 Lo A -'}\-_'
E T Ydlg
R 2 [i=
i - _} 1 Single Offset Entire Element
T-.‘Q_ ™y — |
— {_} 2 Single Offset Partial
A_J",wf tT__

3 Variable Offset Taper

A Data Acquis :-‘-..:.‘.: 4 Ratio Defined Taper

N Drawing 3. 5 Offset Transition

[d Drawing Co

== Open 'Offsets and Tapers' as Toclbox

1. Create an offset alignment off the previously created Outer Road alignment from the
radius returns on the east and the intersection at the west end to create an EOP see dialog
box below for Name Prefix.

{ Single Offset Part. 2| B | X
[[] Offset 0.0000
Distance ~
[ Start 17.6895
[C] End 87.0500
Feature A
Use Feature ®]
Feature Definition EOP New =
Name Prefix EOPNew-OR

29
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2. Click the new OR centerline and for offset, snap to the radius return in the file.

3. Zoom using the mouse wheel to the other end of the alignment and left click just beyond
the end of the alignment. The offset will be created.

4. Repeat this step for the other side of the alignment.

5. Create the EOS on either side using the same process, select EOS New Asph for the
Feature.

6. Save the file it will be used in later chapters.

30
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Chapter-3 Placing the Roundabout

In this chapter the user will begin working with the previously created RAB Item. With the
alignments modified and set up correctly the locating of the library RAB is a simple process. In
this section the user will gain an understanding of:

e Library Browser

e Replacing Approach
e Entry Path Curvature Analysis
¢ In place modifications

Roundabout Library Browser

@ Open library browser, Used to open the configured listing of available libraries for
placement.
=3
= Replace approach — Used to replace an existing approach. This tool will allow you to set
up parameters once on a single approach and copy these settings to a second approach. More
information is available in the “Libraries section” later in the workshop.

@ Entry Path Curvature Analysis - This tool will allow for the analysis of our design
based on the curve path through the roundabout.

Open the message center — Opens message center to reveal all messages, warnings and
descriptions.

@ Show Properties- Exposes the properties of the selected (active) portion of the
Roundabout these properties change depending on what geometric element or group of elements
is selected.

31
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RAB Horizontal Layout
Select a Roundabout Library

The roundabouts tool uses a library for computing the design. A library is used as a type of seed file
specific to Roundabouts. It defines the parameters for the various calculations required for the
roundabout design. As we discovered in Chapter1 the seed is a DGN file which contains a simple
roundabout design. By using these very same roundabout tools the user has the ability to create or
modify libraries, creating “Seed “Roundabouts which contain the parameters used most.

Open the RAB_Training.DGN from the folder C:\Data\ J9/2184. (file cannot currently reside in
ProjectWise)

Warning: Verify the Project Preferences COGO Preferences are pointing to the correct folder
C:\Data\J9/2184. (file cannot currently reside in ProjectWise)

Open the GEOPAK Project

1. Open]912184.prj from C:\data directory
2. Open COGO, make sure 218.gpk is being used

Open the Roundabout Library Roundabout Library Browser X
X %= % (O] @
1. Open Create Roundabout task. % RAB_LIBRARY don =
Tacks (=] -4 TYPO1_2LN_APR

= TYP_A_EXIST_TIE
2 - !@_ = TYP_A_EXIST_TIE

| = TYP_A_EXIST_TIE
— @ 1 Open Library Browser B TYP_A_EXIST_TIE
=) TYPO1_4LN_APR2

ﬂg‘ 2 Replace Approach # B ALANE-NARROW -
% 3 Entry Path Curvature Analysis = TYP_A_EXIST_TIE

= 4LANE-WIDE |

=3 Open as ToolBox = ENTRANCE B

4 L »

2. Click the “Open Library Browser”.
From the Roundabout Library Browser use the “Add” button and add the Library

RAB_LIBRARY.dgn from C:\Data\Standards

3. Expand the RAB _LIBRARY. Highlight any of the approaches. - Notice the preview updates with
the corresponding approach.
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Roundabout Library Browser

h X =R QL@

=~  RAB_LIBRARY.dgn
=4 TYPO1_2LN_APR
= TYP_A_EXIST_TIE
2% TYP_A_EXIST_TIE
B TYP_A_EXIST_TIE
. .= TYP_A_EXIST_TIE
# TYPO1_4LN_APR2
=X 4LANE-NARROW
2% TYP_A_EXIST_TIE

-~ =8 4LANE-WIDE
-2 ENTRANCE
< | m

Transition Offset Rule 4
Median Width -0.8202
Median Width 0.8202
Approach 4
Name TYP_A_EXIST_TIE
Type Parallel Side Triangle
Create Island Yes
Roadway Type Dual

Approach Length Typ« Length

Approach Length 3249954

Offset No
i Entry
'R} R @

N

=

B=

The Civil Library Browser
allows the user to review all
the features in the selected
RAB. By highlighting the
different features the user can
drill down into the RAB
geometric design, each
heading revealing different
information.

Additionally a preview of the
RAB selected is shown on the
Bottom Pane.

This browser stacks neatly
into the Task Menus and can
function as any other Task
Menu.
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Create the North Roundabout

1.

With Type01_2LN_APR roundabout selected in browser, the Place Roundabout button

+,
becomes active. 'Q Click
the button.

Select the RTE63 Relief
alignment -2 lane
roadway

Right Click (Reset Button).
Now you are prompted to
set the center of the
roundabout

Notice the prompts at the cursor to direct you to
what is being asked for input. These are the same
prompts that appear in the status bar. In this case
the user is prompted to select the reference
element (Alignment).

Position the RAB center to the intersection of the alignments.

Note  Wherever the data point (DP) is placed will be the center of the
roundabout. There are certain advantages to using the intersection of the
alignments to make the roundabout symmetrical. Additionally, there is no
requirement that the alignments must intersect. The only requirement is
that each approach alignment must intersect the circulatory area of the

traffic circle.
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Change the Center Roundabout Information
1. Select the Center Circle of the Roundabout with the Element Selection tool.

2. Using the Element Information tool, Change the Circulatory area and Arc Rule Radius
to match the configuration below.

© tmen omston Y -

=4 Roundabout: TYPO1_2LN_APR A
w

1 @-=¢ Approach: TYP_A_EXIST_TIE

(+-== Approach: ENTRANCE

l #-==% Appioach

@-=¢ Approach: TYP_A_EXIST_TIE

m

Circulatory Area ~

Over Run Visible Yes
Circulatory Crown Visible Yes
Subsidiary Crown Visible No
(@ Center Point [C5] 1838685.5077.768034.

Transition Offset Rule ~

Circulatory Crown Offset 20.0000
Subsidiary Crown Offset 8.0000

Circulatory Width 40.0000

Over Run Width 3.0000

Arc Rule ~
Radius 95.0000

Change the North Approach

This is a 2 lane roadway with 12’ lanes and 6’ each side median. We need to modify the north
entry and exit geometry to match the existing roadway lines.

3. Select the North Approach with the Element Selection tool.

@

4. Use the Information Tool to change the following:
e Offset the North Approach -20
e Entry Lanes and exit lanes to 1. And 12’ lanes

e Change the Median width to -6.00 and 6.00 on each side.
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Roundabout: TYPO1_2LN_APR

-4 Creulatory Area

st

@-=¢ Approach: ENTRANCE =

=% Approach: TYP_A_EXIST_TIE
Approach 'S
Name TYP_A_EXIST_TIE
Type Straight Side Triangle
Create Island Yes Infor v atic
Roadway Type Dual - —
Approach Length Type  Length B" Approach: TYP_A_EXIST_TIE -
Approach Length 400.0000 -2 Complex Blement: Road Centeriine1 |
Offset Yes @-= Median [
Offset Type From Center Point = 5
Offset Distance -20.0000 == BExt Lanes

_ Offset Radius 16404167 = (#)-[> Deflection Area v

Transition Offset Rule ~ Lanes ~
Median Width -6.0000 Number Of Lanes 1
Median Width 6.0000 Widening No

E+J— Median
=== Entry Lanes
o= TN
[-== Exit Lanes
@[> Deflection Area

=t Approach: TYP_A_EXIST_TIE N S
. @& Complex Blement: Road Centerline3

E |

Transition Offset Rule

| Width 12.0000
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e Modify the Deflection Area using the Element Information tool. Notice which
dimensions are affected by changing them in the dialog box.

[#)}-== Entry Lanes

[#)-== Exit Lanes
®-7 Flare =]
@-s=¢ Approach: ENTRANCE =
#-=¢ Approach g
Entry ~
Offset © 20.0000
Back Radius 328.0833
_Er_o_nt F_!adius 82.0208
Exit P
Offset 20.0000 '
Back Radius 328.0833
Front Radius 82.0208
Construction ~
Length 82.0208
Offset 1.0000
Entrance Side Base Widtt 12.0000
Exit Side Base \Width  20.0000
Height/Base 25632
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e Change the Island information for the North Approach.

-0 2 L
@ Arc: 620-60. =
@S Complex Bement: 620-60.1
@S Complex Element: 620-60.2
I &7 Flare
|
Entry ~
i Type Offset ]
Corner Radius 1.6404
Front Offset 1.6404
| Back Offset 1.6404 |
Exit ~
Type Offset
Corner Radius 1.6404
Front Offset 1.6404
| Back Offset 1.6404
Front ~
i Type Offset ]
Entry Offset 3.2808
Exit Offset 3.2808
Back ~
[ Corner Radius 43963 i

e Modify the Flares for the roundabout. Use Element Selection to select the flare
and Element Information tool to change the information for the West Side Flare.

(i) Element Info Q=X
G-== Exi Lanes
@#-[> Deflection Area B
=~ 8 =
@-=t Approach: ENTRANCE '
@-==¢ Approach -
Flare ~
Approach Radius 328.0833 '
Entrance Radius 125.0000
Dffset method Linear variation
Exit Radius 75.0000
Departure Radius 328.0833

Theoretical Entrance Wid 20.0000
Theoretical Exit Width  20.0000
Achieved Entrance Width 24.5268
Achieved Exit Width 21.0447
Effective Entry Flare Lenc 36.5394
Entry Angle 11.908"
Sharpness of Entry Flare -0.2741
Maximum Entry Angle  60°

Minimum Entry Angle 10°
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Change the South Approach

This is a 2 lane roadway with 12’ lanes and 6’ each side median. We need to modify the south
entry and exit geometry to match the existing roadway lines as we did the north.

1. Use the same tools and methods to modify the south approach. Set the following
parameters for the South Approach.

e North Roundabout South Approach and Entry and Exit lanes (Both 1 lane 12")

o =
#)-S. Complex Element: Road Centerdine5
[#-== Median
[#)-== Entry Lanes
[#)-== Bxt Lanes
#-[> Deflection Area

Approach ~

Name

Type Parallel Side Triangle

Create Island Yes

Roadway Type Dual

Approach Length Type  Length , 1 e

Approach Length 250.0000 #)-5. Complex Element: Road Centedine5

Offset Yes #-== Median

Offset Type From Center Point =-== Entry Lanes

Offset Distance -10.0000 @#-== Lane 1 =
_ Offset Radius 1640.4167 _ &= Ext Lanes i

Transition Offset Rule a | =

- Transition Offset Rule ~
Median Width -6.0000
Median Width 6.0000 . \width 12.0000
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e North Roundabout South Approach Deflection area and Island info

Fars (> Deflection Area
SR> Deflection Area - | | @ Ac: Roadway (Edge)12 =
bl | | . Conplox Boman: Foucvay Cranrst 3
@ Arc: Roadway (Edge)12 e i | @-2 Complex Blement: Roadway (Channel) ~
-5 Complex Blement: Roadway((.‘.‘namel)'—J ol i ] ¢
. @5 Complex Bement: Roadway (Channel) ~ Entry
< | m ] » Tyme S
Entry -~ Corner Radius 1.6404
o 200 i —
. Back Radius 328.0833 ; :
__ Front Radius _82.0208 | Exit
| Exit PN Type Offset
e —_— Corner Radius 1.6404
Offset 20.0000 [ Front Offset 1.6404
Back Radius 328.0833 . Back Offset 1.6404
Front Radius 82.0208 '
Front
Construction ~ Type Offset
Length 82.0208 Entry Offset 3.2808
Offset 2.0000 ||| ExitOffset 3.2808
Entrance Side Base \Widtt 15.3789 ;
Exit Side Base Width  10.0000 =
Height/Base 3.2319 | |I| Corner Radius 4.3963

e North Roundabout South Approach Flare

[#-== Lane 1 -
== BExt Lanes

(-== Lane 1
@[> Deflection Area —
(R Flare | [

@)= Approach: TYP_A_EXIST_TIE -

Flare ~

Approach Radius
Entrance Radius
Offset method
Exit Radius
Departure Radius

200.0000
65.0000

Linear variation
65.0000
200.0000

Theoretical Entrance Wid 2.0000
Theoretical Exit Width  2.0000
Achieved Entrance \Width 16.4769
Achieved Exit Width 8.4993
Effective Entry Flare Lenc 21.7868
Entry Angle 215176°
Sharpness of Entry Flare -0.1623
Maximum Entry Angle  60°
Minimum Entry Angle 10°
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Replace the East Approach Roundabout Ramp Entrance

1. Expand the roundabout library TYP0O1_4LN_APR2 and select the TYP_A_EXIST_TIE
approach.

&-/ 1 RAB_LIBRARY.dgn
-4 TYPO1_2LN_APR
=4 TYPO1_4LN_APR2
S 4LANE-NARROW

= TYP_A_EXIST_TIE

m

AL ANEWID |
= ENTRANCE -
< m | )

Approach ~
Name ENTRANCE
Type Straight Side Triangle
Create Island Yes
Roadway Type Single
Approach Length Type Length
Approach Length 324.999%4
Offset No

1
2. Select the Place Approach Icon - and select Circulatory area of the roundabout. @

And the souﬁe ?f thereast ramp pavement. @

Q
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Additional warnings JS may appear referencing the entry angle. This angle is critical in the
geometric design of the RAB. Typical min-max requirements for this angle should range 10° to 60°.
The greater the angle the more the speed is reduced for traffic entering the RAB.

3. Change the approach to match the following dialog. As you change any box, notice the
change on the screen.

(@ Element Information =

=-X

#-==¢ Approach: TYP_A_EXIST_TIE

Approach

Name TYP_A_EXIST_TIE
Type Parallel Side Triangle
Create Island Yes

Roadway Type Single

Approach Length Type  Length

Approach Length 324.9994

Offset Yes

Offset Type From Center Point
Ofiset Distance 16.4042

Offset Radius 1640.4167

42




[ROUNDABOUT WORKSHOP]

e North Roundabout East Entry Lanes

&=t Approach: TYP_A_EXIST_TIE S|

== Approach: TYP_A_EXIST_TIE -

-5 Complex Blement: Road Centerdine 10 @S Complex Element: Road Centerdine10
[5)-== Entry Lanes )= Entry Lanes
= [N : )= Lane 1 -
[#-== Exit Lanes |_.J -== Exit Lanes 4
#-[F> Deflection Area - & —- =
Transition Offset Rule ~ Transition Offset Rule ~
Width 16.0000 [ [ [ width 1.0000

e North Roundabout East Entry Lanes Deflection area

Offset 14.7638 :
Back Radius 328.0833 .
Front Radius 82.0208 |
Exit ~
| Offset 14.7638 ;
Back Radius 328.0833
L_Front Radius 82.0208
Construction -~
Length 82.0208
Offset 1.6404
Entrance Side Base Widtt 2.0000
Exit Side Base Width  5.1263
HeighlfBase _11.509%
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North Roundabout East

Entry Island info

' :
‘2. Complex Blement: 620-60.15
&

Complex Blement: 620-60.16

Entry

Type

Corner Radius
Front Offset
Back Offset

Exit

Type

Corner Radius
Front Offset
Back Offset

Front
TYDG

Entry Offset
Exit Offset

Back

Corner Radius

Offset

1.6404
1.6404
1.6404

Offset

1.6404
1.6404
1.6404

Offset

3.2808

1.6404
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e North Roundabout East Entry Flare

Flare ~
Approach Radius 200.0000

Entrance Radius 75.0000

Offset method Linear variation

Exit Radius 65.0000

Departure Radius 200.0000

Theoretical Entrance Wid 2.0000
Theoretical Exit \Width ~ 20.0000
Achieved Entrance Width 16.4735
Achieved Exit Width 19.9595
Effective Entry Flare Len¢ 57.7009
Entry Angle 13.0892°
Sharpness of Entry Flare -0.0065
Maximum Entry Angle  60°
Minimum Entry Angle 10°
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Replace the West Approach Roundabout Ramp Exit
1. Expand the roundabout library TYPO1_4LN_APR2 and select the ENTRANCE approach.

North Roundabout Exit Ramp West Approach

@#-(> Deflection Area
[~ Hare
- =t
=% Approach
@-==t Approach: TYP_A_EXIST_TIE
Approach
Name ENTRANCE
Type Parallel Side Triangle
Create Island Yes
Roadway Type Single
Approach Length Type  Length
Approach Length 400.0000
Offset Yes
Offset Type From Center Point
Offset Distance -20.0000
| Offset Radius 1000.0000

Entry and Exit lanes for North Roundabout West Exit Approach

© Eement © Element Informat
[=-==¢ Approach: ENTRANCE - E-== Approach: ENTRANCE
4S5 Complex Element: Road Centeriine6 | @5 Complex Element: Road Centeriine6
=}-== Entry Lanes [=}-== Entry Lanes =
= [ETN E - Lane 1 E
= Lane 1 - == BT -
Transition Offset Rule ~ ' Transition Offset Rule ~
wicth 1.0000 [ ] [ widen 16.0000 ]
L Il
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North Roundabout West Exit Deflection area and Island info

Entry ~
Offset 5.0000

Back Radius 328.0833

Front Radius 60.0000

Exit ~
Back Radius 328.0833

Front Radius 60.0000

Construction ~
Length 70.0000 '
Offset 1.6404

Entrance Side Base Widtt 2.0000

Exit Side Base \Width 10.0000

Height/Base 5.8333

North Roundabout West Exit Flare

E [ Deflection Area
a-p> EEE
| @ Arc:62060.7
| @S Complex Element: 620-60.8
| @2 Complex Element: 620-60.9
Entry
_Type Offset
Corner Radius 1.6404
Front Offset 1.6404
Back Offset 1.6404
Exit
_Type Offset
Corner Radius 1.0000
Front Offset 1.6404
Back Offset 1.6404
Front
_Type - Offset
Entry Offset 3.2808
Exit Offset 3.2808
Back
Corner Radius 1.6404

[#-== Entry Lanes
{#)-== Exit Lanes
(- [> Deflection Area
e Flare
l -4 Approach
=% Approach: TYP_A_EXIST_TIE
Flare
Approach Radius 328.0833
Entrance Radius 54.9999
Offset method Linear variation
Exit Radius 79.9998
Departure Radius 328.0833

Theoretical Entrance Wid 2.0000
Theoretical Exit Width 20.0000
Achieved Entrance Width 3.8278
Achieved Exit \Width 19.5819
Effective Entry Flare Leng 23.8755
Entry Angle 17.5434°
Sharpness of Entry Flare -0.0947
Maximum Entry Angle  60°
Minimum Entry Angle 10°
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Entry Path Curvature Analysis

Entry path radius is one of the more important determinants of safety at roundabouts. This is a
measure of the amount of entry deflection imposed on vehicles at the entry to a roundabout.

Note This class is intended to show you how to use the tools to create a good
design. It is not intended to teach you the principals and theories of
roundabout design.

Exercise: Analysis of Design Speed through Roundabout

1. Open the civil formatting dialog Settings > Design File.
2. Highlight the Civil Formatting category.

| Design File Settings

Category
Active Angl
Active chlz EPC Settings 2
Angle Readout First Turn Color [l [255.0.0]
g"ﬁ — Second Tur Color [ [0.255.0]
omaiting Third Turn Color [l [0.0.255) 2

Calor Measurement Methc B-Spline
Data Acquisition .
Bemert Alibutes Entry Distance 164.0417
T Entry Offset 0.0000
Grid Offset from Center | 0.0000
Isometric Entry Offset from O: 0.0000
Locks Exit Offset from Out 0.0000
Snaps Exit Distance 164.0417
Stream Exit Offset 0.0000
Views Vehicle Width 6.5617
Working Units Maximum Approach 600.0000

Crossfall 0.0000 L N

Cida Crimbinn Canmiaes N 200NN

Focus ltem ipti
Select category to view.

3. Scroll to the bottom and set the “maximum approach” to 600’ and the “design speed
units” to MPH.

48



_ [ROUNDABOUT WORKSHOP]

4. Click on Entry Path Curvature Analysis and select measurement method to B-Spline

" Roundabouts

a@“‘

| Entry Path Curvature A.. D = '

Entry Path Curvature Analysis
Measurement Mett B-Spline

5. Select the South approach first, and then select the North approach. Follow the prompts.

The vehicle travel path will be drawn and any encroachments on the circle

or approaches will be flagged. Review the selections and note if any
Alerts or Errors. Check the Message Center and make the necessary
adjustments to correct the errors.

The analysis should result in three warnings and 2 messages.

M Civil Message Center Lo 3
Hide All [ﬂ 50 MicroStation } -QO Errors.l :_ﬂ.’» Warnings [OZMessagesl

Blement Message Description =
;_ICreate Fare Geometry Information Entrance width needs to be greater than or equalto the total lane wi... | i
00&& Flare Geometry Information Entrance width needs to be greater than or equalto the total lane wi...

I\ Create Ertry Path Curvature Geometry Waming Entry Path Curvature crosses the Entry Roadway edges.

I\ Create Ertry Path Curvature Geometry Waming Bxt Radius is less than the Entry Radius.

I\ Create Ertry Path Curvature Geometry Waming The deflection path intersects the center island. Reduce the Entry or...

%" Misnlav cnmnlete
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To correct this, the user will need to modify both the theoretical entrance width on the
south approach.
6. Make the following modification:
a. On the Flare on the East side of the south approach, change the Theoretial
Entrance Width to 20’

/ P £ L X1 _Fl I sslartinn — it |
jf/_[ ,: (i) Element Information =N
=- K <Selection>
il Flare |
Flare ~
Approach Radius 200.0000
Entrance Radius 65.0000
Offset method Linear variation
Exit Radius 65.0000
Departure Radius 200.0000
Theoretical Entrance Width
Theoretical Exit \Width 0000
Achieved Entrance Width 18.6556
Achieved Exit Width 8.4993
Effective Entry Flare Length 37.0373
Entry Angle 21.3739°
Sharpness of Entry Flare 40.1435
Maximum Entry Angle 60°
Minimum Entry Angle 10°

7. With the element information dialog open select the entry curve analysis.
a. At this point, the design speed is 33 mph we want to be <25 mph.
b. Reduce the design speed by changing the Entry Path Curvature. By default, the
program assumes the driver will hug the centerline with 0’ offsets. Change the
Entry Path Curvature to match below. What is the design Speed now?

Entry Path Curvature

Measurement Method
Vehicle Width

Entry Distance

Entry Offset

B-Spline
6.5617
164.0000
3.0000

Offset from Center Islan 2.0000
Entry Offset from Outer 1.0000
Exit Offset from Outer E 1.0000

Exit Distance
Exit Offset

164.0000
0.0000

m
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Other modifications to the RAB geometry could be used to remove these warnings such as
increasing the exit lane width or increasing the exit curve radius. These modifications
would act to allow for increase speed rating when leaving the RAB.
Repeat the previous steps for all approaches.
Note Place one Entry Path at a time and resolve any issues you may have
before moving to next approach to minimize the number of Alerts you
need to adjust.

When selecting the Roundabout or its Approaches, the designer will see the entry curvature
analysis results in addition to the previously seen design data.

Select an Approach and open element information. Review your information on the Calculated
Design Speeds for each Approach.

It is easy to see how the dynamic editing capabilities of civil platform can benefit the
designer. As we finish this courseware work has begun on the next phase connecting
vertical geometry to these dynamic geometric elements.

Summary

You are now able to:
= |dentify the parts of a roundabout

=  Create a Roundabout Library

=  Have a basic understanding of the rules based approach as it pertains to design using
the roundabout tool.

®=  Understand the concepts to manipulate your RAB design.

= Analyze the design with the entry curve analysis tool.
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Chapter-4 Model Set Up

RAB Model Overview

In this chapter the user will gain insight into what needs to be completed prior to creating the
finished model of the Roundabout. Prior to activating the corridor design tools the vertical
geometry (Profiles) of the roadways need to be established. To begin the designer will focus on:
e Establish preliminary grading using DTM tools, Roadway designer tools or GEOPAK
Site Modeler
e Establish the profile of the connecting roadways in the area of the RAB

e Create the Circulatory Area Chain (Alignment) and Profile

It is important to first understand the requirements of the project prior to modeling the RAB; in
some instances the designer may opt to use GEOPAK Site Modeler. While Site Modeler alone
allows for quick modeling of the final surface it does not interact on the same level as the
Corridor Modeler. The Model referred to in this workshop will guide the user through the
process using the Corridor Modeling tools.

Establish the RAB Rough Grade

Bentleys Site Modeler is an excellent tool for developing quick, highly adjustable surfaces. In
short Site Modeler simply builds TINs. The designer could also opt to create these rough
construction surfaces by using other tools such as the DTM tools or roadway designer. For the
purpose of the workshop we have opted to use the Site modeler application for the following
reason:

®=  Quickly generates surfaces

= Surfaces can be profiled using the same process as used in GEOPAK Road

®=  Can be used downstream to complete a finished 3D model of the entire site that is
easily updated.
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Creating the Modeler Project

With the Horizontal (Chains) in place for Rte 63 and The ramps (1-4)and the profile for the Rte
63 having been established the user can now design a rough grade plane using the PGL as the
starting point of the RAB surface.

1. Open RAB_Training_Chapter4.dgn from CH4 Folder

2. Open GEOPAK Site GEOPAK > Site> Site Modeler>Site Modeling

3. Toggle create New Project from the Project Wizard dialog > Click Next

< Prev

<No Projects> v

@ Create New Project
] Dont show this dialog on Startup

") Open BExdsting Project:

4. Place in folder C:\Data\J912184\ name it “RAB_Training_Chapter4.gsf” > Click next
5. Toggle create a new Model > Enter name RAB Train
6. Click “set Project preferences”

[(Prev][Next)]

[V] Create a New Model
Model Name: | RAB Train

| Set Project Preferences |

7. Click File> Open> select from the “Standards folder MoDOT _Site.spf

M Site Preferences - Tolerances ‘L’E‘i"’i‘lﬂ]

File

—C_)ptions J Linear Stroking: | 25.000
?‘Wm Curve Stroking: | 0.010
roject ponents i
Niiabsation Comer Stroking: | 10.000
Objects B-spline Profile Stroking: | 0.001
Updating Maximum Triangle Length: | 100.000
i Blevation Decimal:

[ oK | [ Cancel |

8. Click OK
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9. Click Next on the project wizard dialog
10. Toggle “Open Object Import Wizard”

| M Project Wizard sl i

[ < Prev ] [70}( ]

New Project = .. \RAB_Training_Chapter4 gsf
New Model Name = RAB Train m

[¥] Open Object Import Wizard
11. Click OK
12. Set the dialog to:

File Type: TIN File

File Name (Browse): C:\Data\J912184\J912184.tin
13. Click Next- set the dialog as shown below

“ Import Data Wizard Lﬂ
Select Object Type: [<Prev][Next>]
[Existing Ground =

ErluNewOb,eclName
B

&+

14. Click Next > Toggle ON “Use as Base Object For: Model : RAB Train”
15. Click OK
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Create the Construction Object Surface

1. From the modeler dialog Create a new Object modeler Object > New

Object | Elements Tools Analysi

[ New..
Edit
Copy Object
Move Object
Raise / Lower
2. Set the dialog
a. Type: Construction
b. Object name: CO1

Note Do not toggle add to active Model- This creates an “Orphan Object” this
means the object (an object is simply a surface) will not merge into the

Base Object
3. Click OK... The object should now appear in the Active Site Object Control

Active Site Object Control D
V1 Display View (1_¥) Model [cOphan Objects: v | Object [CO1 - D B

4. Open the Elements New Edit dialog — Modeler > elements > New/edit
5. Set the dialog as shown below

M New / Edit Site Elements -> Alignment @_ﬂ
(7] Add to Active Object: [CO1 v) [ New... | [ Aoply |

Blement | Point | Section || Display |

' Primary Element Definition
. N A ary
' /\/‘\4’:\#&&% Job: (218 | @@
-~ Bet Chain: [RTES3 =
(By Level Symbology ~] Profile: (RTEG3NEW v
Feature: < No Entries > v [V] Use Station Range
Superelevation Begin: | $+00 “n
(] Include Superelevation shapes from DGN End] | (200 fees]
Type [Tie v| 10.000 include Blement  ~
6. Click “Apply”

55



_ [ROUNDABOUT WORKSHOP]

Note  Once Applied- an element will be created between the station range using
the level or feature symbology active on the dialog
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7. Change the command mode on the New / Edit Site Elements Dialog to Slope/ Offset
8. Follow the Diagram below to select the element-select the reference and apply

Bt New / Edit Site Elements-> Slope/Offset From Site Element (s e ¥ et stauon nar
W) Addio e Object: @01 ) [New] [ fosl [
| Bepent | Port. | Section | Diply | %
!@* f’;};(:{,”ji’f’ Define Blements

I:J | He o
Festre Type: (Boundary ) #1 [ [ P

@] 1500 7] Redefine Ste Bement
7] Ofiset Height: | 0,000 Reference Bement -
Projecton Option: Source #2
[¥]{Use Reference Element Association] -
#1 Click Define +1.5% SLOPE FROM BASELINE
Eelment- Select
dash Line

#2 Select the
Reference Element
Rte 63 CL

#3, Click Apply.

9. Repeat the process to add the dashed line to the east of Rte 63 at a -1.5% slope

57



_ [ROUNDABOUT WORKSHOP]

*

10. Export the newly created CO1 Modeler > Project > Export> Model/Object
11. Set the dialog as shown below and click Apply

M Export Model / Obj... licaului=h S

@) Model: [RAB Train ~]
@ Object: [CO1 v
Export Type:

Fie Name; | SONIE Q

| Use Boundary: | Place Select

Creating the Circulatory Alignment

At this point various geometry has been created by placing the RAB the geometry should
include:

e Circulatory Curves (These will have to be constructed into a Chain)
e 4 Flares- NW, NE, SW, SE

Using the CO1 construction surface as a guide the user can now set the RAB Circulatory Profile
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Create the Circulatory Chain / Profile

Currently a chain using a circle does not produce desired results in GEOPAK. So for a chain to work
properly, we will create 2 arcs along the Circulatory area of the Roundabout and Store Graphics for
the alignment (chain) of the roundabout.

1. Select the Place Arc tool
2. Set Method to Center, Start

i

"G Place Arc li_i]‘/'.'

Method (Center. Stat v

D = : Circulatory Area

("] Length: Level: Roadway-Edge of pavement
[7] Stat Angle: ' A
("] Sweep Angle:

[] Drectin: ~ (CCW_~)

i Circulatory Area
¥/ Level: Roadway-Edge of pa

4. Store Graphics of the Arcs created to store curves “CIRC1” and “CIRC2”
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5.
6.

.

| Lo

L ER

1o |

=)

Open as ToolBox

A& L coco

My 1
“ﬂgg 2 Graphical COGO

Pt 3 Horizontal Alignment Generator
,d_ié

. 4 Design Multicenter Curve

aaey
A3 E]g Store Graphics

L)
66 | 6 Auto Store Graphics
m? ’i»-o- = P
; 7 Subdivide Wizard

VPI Based Vertical Alignment Design Tools

Component Based Vertical Alignment Design Tools

Legal Description Editor

M Store Gra.. =205

Settings

|ttt

Operator Code: | du
CIRC2

(BBener ] [ o

ID Element, Select the first arc created and Store the Curve
ID Element, Select the second arc created and Store the Curve

M Navigator(218)

— R ey

S ——

Select Tools

idd Rn®

N X H

Element i [Curve v/
Name | Feature | Description | Select | P.C. Station | P.T
CIRC1 0+00.00 2+
CIRC2 0+00.00 2+
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7. Open Coordinate Geometry
8. Click Store Chain From Elements
9. Add the two Curves created

Coordinate Geometry Job: 218 Operator:du = 28

le Edit Element View Tools

REZ k¥ LS RCOKE RGPS oo # # |
*) J7) [¥] Bedefine (Temporary Visualization )| OFF (Featue) [+] =

3 = “ Store Chain From Elements = =
30 Keyin: | 68034.8556f e — i S
Chain Name: | CIRC Blement Selection
Beg =) | Bement Type: (Cuve ]
ME— | vpe
Element List] CIRC -
<Add | |CIRC2 (]
CUR CIRC1 CUR CIRC2| |<Add ] ClRce._ I
urve CIRCZ RAMP1-2 |
.I. Station RAMP2-1 £
elta = RAMP3-1
egree - RAMP4-1
angent = [ Store Chai ] RAMP4-2 <
ength =
adius = —

10. Click Store Chain “CIRC”

11. Close COGO

12. Open the “Ground Profile” tool- GEOPAK > Road > Plans Preparation > Ground
Profile

13. Set the Dialog as shown below

M Ground Profile - Untitl... LE.L:'_ﬂ

Profile Name: A CIRCEX I
Job Number: | 218 Q
Operator: | du
Offset: | 0.000

Beg Station: | 0+00.00

End Station: | 4+71.24
5.000 (TN~
Radius of output circle: 10.0

TIN File: | C:\data\J912184\JSI12184tin | Q
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14. Click Apply > Click “OK” to store inp > Click YES to store Profile > Click YES to

“Delete Profile String”
15. Close the dialog

Creating Existing Profile View using GEOPAK Site
16. Create a profile- modeler > Object > draw profile

17. Place profile Cell- Click the Dialog Place profile Cell
M Draw Profile =
File Edit Update Options

Chain: CIRC v)

Job Number: @f Label Scale: [50.0

JUuuv

Sufoces [COGO | Prjecion |

|Dialog Profile Cell Control|

Type | Name Display Settings Draw J

d

18. From the Profile cell Control dialog follow the steps in the diagram below

M Profile Cell Control o

Active Chain: [CIRC =

Microstation File Station Blevation H.Scale V.Scale Gap

$ Place Profile Cell
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| M Profile Cell Control &
Active Chain: [CIRC |
Microstation File Station Bevation H.Scale V.Scale Gap |
® A Active Design 0+00.00 850.000000 10.00 1.00 a
®
X

19. From the “Draw profile” dialog select the “Surface tab”
20. Set The dialog as shown below — Click “Add” to display the CO1 surface

M Draw Profile = =
File Edit Update Options
Job Number: (218 _~] £ ﬁ Label Scale: | 0.000000
Chain: [CIRC 2
Sufaces | COGO | Projection
Type | Name Display Settings | Draw |
0BJ CO1 Lv: Profile-Existing ground line.... ad
X
&
Details
(Obect v) [co1 3
Method:
Display Settings Filter Tolerances
[By Level Symbology v] |mmmmmmm- Horizontal: | 0.30
Feature: (< No Entries > v | Variance: | 0.10
Station Limits Offsets
[¥] Begin: | 0+00.00 4 Horizontal: | 0.00
End: |4+71.24 @ Vertical: | 0.00
[]Void [mmmmmn=n [7] Breakline Text Sompie

o ————
- -
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Creating Proposed Profile

21. Repeat the process to create existing ground, This time use the CO_N surface as the
Existing ground. This will place the profile for the circle on the desired plane.

Note Identifying the cell will update the X, Y reference information

22. Save your profile as CIRCEX2.

- . ! ) BT

" M i =] L.
- ppebipibehibEeh B SEISSIGGCRIEREUAN,

§ B
. Bl
1+ |
v | T e e
- i I ¢ R i il M"’“‘-hs,‘_
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Create the Flare Alignments and Ramp Profiles

Creating the Flare Alignments

Vi W

Use the MicroStation Create Complex Chain tool
Change the method to Manual
Select the elements that make up the Flare (leave out any bsplines)
Click the Store Graphics tool

Set the Dialog box as shown below and ID Element >select the Complex chain created from

the North East Flare. This will require you to reset (right click) several times to select the

complex chain. Watch the Status bar at the bottom of the screen to make sure you select the
Complex Chain and not the Flare. Selecting the Flare will not store the chain.

M Store Gra... EK_E

Settings

Job: | 218
Operator Code: | du

Q

§ U

6. Click the Store button. '

7. Repeat this for each Flare on the Roundabout.

M Navigator(218) el RS M Navigator(218) e e
Select Tools Select Tools
N xFid & B NXBid & By

| e

Bement | [Chain - Blement : [Curve -
Name Feature| Name Feature | Description Select | P.C. Staton | P.T. Station |
CIRC CIRC1 0+00.00 2+3562
FLARENE CIRC2 2+35.62 4+71.24
RAMP1 FLARENE-1 0+00.00 0+69.60
RAMP2 FLARENE-2 1+24.10 1+50.57
RAMP3 FLARENE-3 1+50.57 1+90.36
RAMP4 ' FLARENE-4 1+90.36 2+56.96
RTEE3 FLARENE-S 2+56.96 30668
RAMP1-1 3+74.28 6+24.28

The chain is now stored for FLARENE along with the curves that make up the flare.
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Note:

Flares are often made up of bsplines, which GEOPAK may have trouble with. If you continually
crash trying to create a flare in this manner, try dropping the complex chain and replacing the
bspline with a smartline, then recreating the complex chain. Or when creating the complex
chain from the flare, skip the bspline.

Create Ramp 1 Profiles

RamplEX
RamplNew

1. Open the Ground Profile tool

Applications | Window Design Construction Add-Ons Help Email

GEOPAK  »  Deactivate GEOPAK | 2 AR N0 _J E

Map »

P
.ZJ'“*.'}P’v if

Training

|_ROAD »|  ROAD Tools

SITE y
SURVEY i1
DRAINAGE y | Corridor Modeling
About GEOPAK Site Modeling

i Active Chain Control

= Element Attributes

: 3PC AdHoc Attribute Manager

Project Manager

Ao S wnend  User Preferences ot bt
Geometry »
Design & Computation Manager
Quantity Manager

| Plans Preparation »  Plan View Labeling

DTM Tools DP Station/Offset
3D Tools »  Draw Transition
Cross Sections »
Utilities >

Draw Cell by Feature
Draw Cell Group by Feature
Help Draw Cell Area by Feature

Pavement Markings

Draw Signs

Profile Labeling
Ground Profile

- L
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2. Setup the Existing Ground Profile RAMP1EX

M Ground Profile - Untitl... lE]_"g

Noukw

Profile Name:
Job Number:
Operator:

Radius of output

RAMP1EX
218 Q
du

RAMP1

: 1 0.000
: | 0+00.00

13+42.99
5.000

crcle: | 10.0

TIN

TIN File: | C:\data\JSI12184\J912184 tin

B

K

Q

Click OK to store the inp file

Click Yes to Store the Profile

Click Yes to deleting the 3D string
Close the dialog

Draw the Profile in to the Drawing

1. Applications> GEOPAK> Road> Plans Preparation> Draw Profile
2. Change the active chain to RAMP1 and click the Dialog Profile Cell Control tool

3.

M Draw Profile

File Edit Update Options

JobNmber:

Chain: (RAMP1 v

)

Sufaces | OGO || Projection |

Label Scale: [0,000000

a|

In the Profile Cell Control Dialog, choose the add button
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4. Set the Place Profile Cell dialog as shown below:

{ Place Profile Cell (=2

5. Place the profile Cell.

The Cell will show on the screen and in the Profile Cell Control dialog.

, M Profile Cell Control ol
Active Chain: (RAMP1 v |
Microstation File Station Eevation H.Scale V.Scale Gap |
® A Active Design 0+00.00 850.000000 1000  1.00 a
®
X

6. Inthe Draw Profile box, add the CO_N.tin and J912184.tin on the Surfaces Tab.

M Draw Profile o =
File Edit Update Options
Job Number: £ E Label Scale: | 0.000000

Chain: [RAMP1 |

Type | Name Display Settings Draw_|

TIN CO_Ntin Lv: Common-Misc details, Co: ... (@]

TIN  J9I2184tin Lv: Common-Misc details, Co: ... (m]
X
®

Nat aile
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T T

The top line is the Roundabout Surface created by GEOPAK Site. The lower line is RAMP1EX. This could
have been drawn in using D&C Manager as well.

Create a New Profile Matching the Roundabout and Existing Elevation

1. Open the Layout Profiles (VPI Based) tool

Applications | Window Design Construction Add-Ons Help Email

GEOPAK  »| DeactivateGEOPAK | | 9 : )~ g3~ 2 ~ & @ i} Eﬁ &2 1’%
| . 3 : iy =) —=

Map »

Training
| ROAD *|  ROAD Tools

SITE . Project Manager ection | = S

SURVEY b

DRAINAGE y Corridor Modeling o / @

About GEOPAK . Site Modelin p '

= e a9 L .
Active Chain Control
Element Attributes
3PC AdHoc Attribute Manager
User Preferences
Geometry » | Coordinate Geometry
Design & Computation Manager Graphical Coordinate Geometry
Quantity Manager Layout Alignments Horizontal
Plans Preparation » | Design Multicenter Curve
PINSEcoks Store Graphics

N 20 Tools ) g Auto Store Graphics

s Sectings *|  Subdivision Wizard
Utilities 4

o= i Layout Profiles (VPI Based)
Iieip =
————————r Layout Profiles (Component Based)
\ / Legal Description
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2. Set up the Settings Dialog box, be sure to Identify Cell and select the RAMP1 Cell created earlier.

M Settings
Job: | 218 Q
Operator Code: du
PGL Chain:
Location and Scales

Horizontal Scale: | 10.000000
Vertical Scale: | 1.000000
Reference Station: | 0+00.00R 1
Reference Blevation: | 850.000000

X: | 1847981.9072
Y: | 765854.78340
Profile Cell

(DonCalaxy ) [ iemycal

Lok ][ Concd |

3. Start the first Station at the beginning of the existing profile (RAMP1EX) line

M Profile Generator (K Value Table: KValues_2001english.kvi) = P
File Tools
VPI1 VPI 2

Station: | 0+00.00 Station: | 0+40.21

Bevation: | 858.06 Bevation: | 858.60 [ofF _~)
Back Grade: | 1.3610 [oF )

<< Insert i Insert >>

el (<crost] (Dpamc ] [ Doee ) [ioets]

K = =i
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4. Insert the next VPI at the end of the Roundabout Line.

B
g/

5. Insert more VPI’s at the points along the Roundabout Profile line

6. The final VPI should be snapped to the far end of the Roundabout Profile Line

_‘__‘—_-_hh‘h"-ﬁ__
R
M Profile Generator (K Value Table: KValues_2001english.kvl) L
_ File Tools
VP15 VPI 6
Station: | 13+08.55 Station: | 13+42.99
Blevation: | 884.86 Blevation: |884.30
Back Grade: | -1.6340
= << Insert i e Insert >>
e (chost] [Oome] (oo ] [ioei]
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The profile should look similar to the one above.

7. You may now go back and insert any other VPI’s you feel necessary.

ﬂ Profile Generator (K Value Table: KValues_2001english.kvl) LELM
File  Tools
VPI 1 VPI2 VPI3
Station: | 0+00.00 Station: | 3+58.55 Station: | 8+49.94
Blevation: | 858.06 | Blevation: | 863.62 Blevation: | 882.80
Back Grade: | 1.5542 Fwd Grade: | 3.9024

[«hm] [Dn-um.] [Qaleta] Ehsu'l»]

Length: | 358.65 Length: |491.29
Symmetrical Vedical Curve  +
Speec] (65 ~] L: | 36867
Station: | 1+74.31 LP Station: | 1+74.31 K: [ 157.0000 Station: | 5+42.99
Blevation: | 860.76 LP Blevation: | 860.76 SSD: |NA Sevation: | 870.82

(Brevious] 1« () ve

8. Store the profile as RAMP1INEW
9. You may use D&C Manager to place the profile for viewing if you wish

!53....1..__2....3.

Use this same technique to create RAMP3EX and RAMP3NEW profiles.
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5

503

0w 4 H

”L_ﬁﬂ -
TN

880 - F

a0

50
a0
Sl'lf

“0123456?3 q 10

Possible RAMP3NEW solution
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Chapter-5 Corridor Modeling

Overview

The user will complete the design using previously defined Geometry Chains and Profiles. These
include the Road Baseline, RAB Circulatory Area and Flares. In this Chapter emphasis will be
placed on:

e Adding Multiple corridors to project

e Workflow

e Creating Flare surface

e Creating Flare Profile
Open the Project

1. Open the RAB_Training_Chapter5.dgn from C:/data/J912184

2. Open Corridor Modeling — GEOPAK > Road > 3D Tools

3. From the Corridor Modeling dialog load the Road Design Preferences (rdp) File > Load
> C:/data/J912184/218.rdp

At this time take a minute to review the preferences. The following information has been
provided and would be added in the same manner as setting the rdp for a typical corridor
project.
e Template Library = C:/data/Standards/BaseRAB_WS (.itl)
e DTM =J912184.tin and CO_N.tin
e Geometry = RTE63, FLARENE, FLARENW, FLARESW, FLARESE, RAMP1,
RAMP3

e Plan graphics- At this time no plan graphics have been added.
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4. Review the rdp settings

Corridor Modeling - C:\data\J912184\218.rdp —
9
File Tools
i +4 A
Job: | 218 Q| vix A T _‘:g Ve
B Preferences Alignment Name Drafting Standard Display
B DM CIRC MoDOT_Baseline_Proposed
‘ B Geometry FLARENE MoDOT_Baseline_Proposed
] 3 Plan Graphics FLARENW MoDOT_Baseline_Proposed
[ ALG Viewer FLARESE MoDOT_Baseline_Proposed
ie FLARESW MoDOT_Baseline_Proposed
RAMP1 MoDOT_Baseline_Proposed
RAMP3 MoDOT_Baseline_Proposed
RTEE3 MoDOT_Baseline_Proposed

¥iX
5. Tag “Open create Template” '
6. Review the templates — Close Templates

B Create Template ’ ‘ -_‘..—.'__.l..iﬂ
[ File Edit Add Tools |
Template Library Curent Template Drsplay Cose
23 C:\data\Standards\Base RAB_WS Name RA1 @ Components Constraints
"ZZ Point Name List Help
:I P i Description o/ Desplary Pont Names
(2] End Condtions Display All Components

=3 Templates

Ot Sarff Boagk

Pvmt_Surf Conc_T11

rvmi_Sis

\r\ h‘l '_ﬂl'r-;?l S'AL;I!. B

B=
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7. Tag “Open Roadway Designer” 4
8. From the Roadway designer dialog open the CH5_RAB.ird- File > Open

76



_ [ROUNDABOUT WORKSHOP]

The ird contains the corridors leading to the RAB Approaches

e Rampl

e Ramp3

e Route 63
o Flares

The workflow to add the RAB corridors is as follows:
1. Add the Circulatory area corridor
2. Create / edit flare profiles to align with incoming , outgoing, and midpoint corridors
3. Use Flare chain profile as baseline for attaching template — create flare corridors

Add Circulatory Corridor

1. Click the Geometry selection on the left of the Corridor Modeling dialog to display all
the Geometry that has been imported so far.
2. Change the Chain to CIRC, select the CIRCEX2 from the Profiles and Drafting Standard

of MoDOT _Baseline_Proposed.

3. Click Add
4. Click Import to import the CIRC alignment into Roadway Designer.
i ing - . el 3
M Corridor Modeling - C\data\J912184\218.rdp /
File Tools
i + 4+ _A.
oo (78] Q| A PRI 2
1 Preferences Chain Profile Drafting Standard -
= CIRC CIRCEX2 MoDOT_Baseline_Proposed 1l a
RTES3 RTES3NEW MoDOT_Baseline_Proposed .
S amirTolal FLARENE FLARENE MoDOT_Baseline_Proposed
[ ALG Viewer FLARENW FLARENW MoDOT_Baseline_Proposed X
FLARESE FLARESE MoDOT _Baseline_Proposed -
(Gran: [CIRC | Profiels) -
Drafting St MoDOT_Baseline_Proposed v | SARGE £l
— =
\FLARENE -

5. Continue with the Roadway Designer Dialog 4 open and the 001_RAB.ird loaded
6. Tag Manage Corridors

2] iz <l o
Manage Corridors _
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7. Set the dialog as shown below

Limits m
Surface Symbology: [XS P. ] o Ster -
\ vement h
Horizontal Aignment: CiRC v ﬂ Stop: _
Vertical Alignment: | CIRCEX2 v 47124 +| =
Pl Rounding Tangent: (.00
Comidors:

Name Type Source Name Start Station Stop Station -
FLARENW Alignment FLARENW 0+78.06 3+60.95 .
FLARESE Alignment FLARESE 0+00.00 1+95.61
RAMP1 Alignment RAMP1 0+00.00 13+42.99
FLARESW Alignment FLARESW 0+00.00 1+70.45
RTFR2 Alinnment RTFR2 0+00 00 35+09 47 3

4 LU 3

8. Tag the “Add” button and close the dialog — this will add the corridor to the list and set

the Roadway designers focus on this Chain

b AR e e

Conidor: [ClRC‘I v] Station:
Active Surface: [ 1912184 ,.] o [nterval:
Template:

Add template drops

9. Select the Template Drops button (second from left) ‘E‘j
10. Set the beginning station to 0+00

11. Set the interval to 2’

12. Select the RA1 template from the library folder
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B ' Template Drops g -

el
Comdor: - [cIRC )
Saon: 0:0000 L
Interval: 200 ﬂ
e S [ Change |
&3 Templates - D
23 Roundabout
rps
> Flarel =
X RA1 [
> RA11
=< RA12
> RA2 =
: ATV e J Ty - e |
< i )
Cument Template Drops:

Stati... Inter.. Template Enable Tr... Rev... Lbrary
ITL C:\data\Stan...

e B e

9. Tag Add - and close the dialog
10. Set Point Controls under the Corridor Drop down

e

# ° Roadway Designer - C:\data\CH-5 RAB Corrido

File [ Corridor | Superelevation Tools Overlay
llu Corridor Management...

5
-

Template Drops...

. Point Controls...
Fnd Canditinn Fxcentinns...
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11. Set the point controlling the center of the roundabout to elevation 885

e "
Point - ﬂ Station Limits Cose
: Pvmt 1_Conc v
" G (e 8]
) Horizontal @ Vetical *) Both Stop: 4+471.23 i'
Conkeol i hype: | Bevation and Grade ~ | Horizontal Offsets
Blevation: 885.00 Start: (0,00 +|
Grade: 0% Stop: (0,00 +|
|
Vertical Offsets
Start: (0,00 +|
0.00
Priority: 1 _|
Horizontal and Vertical Controls:
E. P. Name  StatSt.. StopSt.. Mode Type Control  Description
| Pvmt_Lay... 0+00.00 4+71.23 i
| |
| |
<| i »
A

12. Close the Point Controls dialog
13. In the Roadway designer dialog tag “Process All”

[ r
ﬂ [ Process Al ]
| Process Visible Range |
Display Mode: @) Normal
) Superelevation
") Overlay
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14. Use the station arrows to view the template drops

r— :
iation: Msc-o ﬂ | Process Al
1000

terval: | ﬁ}ocess'ﬁ'siﬁl'eﬁange

"emplate: RAT Display Mode: @) Nomal
Superelevation
Overay

15. From the Roadway Designer Dialog select create Surface a
16. Set the display as shown > Click Process
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["] New Surface for Each Comidor [ | Create Atemate Sufaces

[¥] Empty Design Surface [7] Process Visible Range Only
| [[]include Null Points [71 Remove Loops
' Triangulate
Features
@ Append Replace Rename Modify
[ Add Transverse Features
Style: Barer_Type_A_617-10 +
[7] Add Bxerior Boundary
Style: Bamier_Type_A_617-10.( ~

Densify using Chord Height Tolerance Display in Plan View
["] Horizontal Curves [7] Features

[] Vertical Curves V] Components

17. Close the reports > close the Create Surface Dialog
18. Review the results and close
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M Load DTM Features - ..\gpk std\DTM\MoDOTIpf [1corliic) e

File
Load File: | CIRCN tin | Q Wl
Display Preferences
Load: V] Display Only  [] Graphic Group
' Feature | Level | Color |Weight| Style | Display =
Contours - - - S ON | ot
Major Lines GeopakContou.. 6 2 3 ON ‘5 o
Major Label Geopak-Contou... 6 4 0 ON o
Minor Lines Geopak-Contou... 7 2 0 ON
Minor Label GeopakContou.. 7 2 0  ON ?
Spots Photo-Spothei.. 7 0 0 OFF ~
|
12 Vi
Distance Between Labels: ' 100.000

19. The Flares have been created for this class, however, view these to see how they were
created. You may also create a Roundabout Surface using the CIRCN circular surface
and the Flare corridors.
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[ New Surace for Each Comidor [ | Create Atemate Surfaces

[V] Empty Design Surface ("] Process Visible Range Only
[7] Include Null Points ("] Remove Loops
[/] Triangulate

Utilizing all of these components will give you a surface for your Roundabout as created through
the corridors.
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20. Save the Roadway Designer ird file — File > Save
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Chapter-6 3D Drive Thru

Displaying in 3D

1. Opendrawing RAB_Training_Chapter6.dgn this is a 3D drawing to accommodate a drive thru
2. Click on the SmartLine tool, and using snhaps, place a complex chain on the mesh that exists
representing the different surfaces.

) the
and
e 63.

kY

or

3. Use the Store Graphics tool to Create an alignment named DRIVETHRU using your newly created
complex chain.

4, Once the Chain has been created, open Corridor Modeling and Load 218.rdp
Applications>GEOPAK>ROAD>3D Tools
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M Corridor Modeling - C:\data\J912184\218.rdp .— et e
_File |giools:|
¥ I i + 4 - A
ob: (2181 Q| i AP R R
[ Preferences _Chain | Profile | Drafting Standard =
= FLARENW FLARENW MoDOT_Baseline_Proposed a
1 Geometry| FLARESE FLARESE MoDOT_Baseline_Proposed Al o
[ Plan Graphics FLARESW FLARESW MoDOT _Bassline_Proposed ‘=
L[ ALG Viewer RAMP1 RAMPINEW  MoDOT_Baselne_Proposed | 8
RAMP3 RAMP3NEW MoDOT_Bassline_Proposed -
Chain} [CIRC AP Profile(s) -
Drafting Standard [MoDOT_Baseline_Proposed v RAMP3EX
[ ) RAMPINEW
RTE63EX E
RTEBINEW M
T e— e
5. Import the new Chain DRIVETHRU into the corridor modeling tool
M Corridor Modeling -c:\dataugulsmliml sl
File Tools
Job: (218 O\m;@‘p;\qﬁgj
~ [ Preferences Chain | Profile  Drafting Standard -
=1 FLARESE FLARESE MoDOT_Baseline_Proposed a
3 Geometry] FLARESW FLARESW MoDOT_Baseline_Proposed =
[ Plan Graphics RAMP1 RAMPINEW MoDOT_Baseline_Proposed H
L[ ALG Viewer RAMP3 RAMP3NEW MoDOT_Baseline_Proposed X
DRIVETHRU RTEG3NEW MoDOT_Baseline_Proposed -
Chain: [DRIVETHRU v I¥ Profile(s) B
Drafting Standard: (MoDOT_Baseline_Proposed v RAMP3EX
[ = = ) RAMP3NEW i
RTE63EX E
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6. Click on the Drive Thru icon in the Corridor Modeling dialog box

P
[ i]\.& 4
4 A ) A
:_\' L

FLARESE

Drive Roadwayl—E

87



_ [ROUNDABOUT WORKSHOP]

7. Set the dialog box as desired. Yours may look a little different depending on where you
drew your chain.

Drive Roadway M |
Horizortal Aignment: (DRIVETHRU v [ Ao |
Vetical Aignment: (RTEGINEW v
Horizontal Offset: 250 __
Vertical Offset: 350
Speed: 5.00
Frames per Second: g
Start: 0+00.00 ﬂ
Stop: 16+4385 +|
Target Distance: 60.00 i]

+

8. Click RUN and watch the drive thru. Did you notice the raised median around the center
of the roundabout?
9. Close the dialog and look at other drive thru’s as time permits.
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Class Final Exercise

What have you learned?

1.
2.

Open The Drawing RAB_Training_Class_Exercise.dgn from C:/data/J912184
Zoom to the area where the Outer Road South hits Rte 63

I
Utilizing the templates, roadway designer files and knowledge acquired in this manual, construct
a roundabout at this location.

Complete as much as you can in the time allotted. At minimum, try to create a roundabout
eliminating errors and warnings.

If time allows, Create a model for the roundabout circular area.

Store South Outer Road Chain

Use 218.gpk

Use 218.rdp

Use BaseRAB_WS.itl

Use RA1 template for Roundabout Circle Template

Use 2 Lane Rural template for South Outer Road chain

Use c:/data/standards/RAB_Library.dgn for roundabout library

Use a 2% slope towards South Outer Roadway in your Site created surface
Use Flare and Flarel for templates for your flares

Create a surface for your circular roundabout and flares

Export drawing to 3D and attempt to run a drive thru of your roundabout
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Appendices

233.3.1.1 Justification for Use

The process of selecting a roundabout as the preferred form of traffic control for a given
intersection has three stages. If a roundabout is not “preferred” at any one of these stages, it will
cease to be considered as a viable form of traffic control at the given location.

Stage 1: Appropriateness.

The initial stage involves a “broad brush” determination of whether the site is appropriate for a

roundabout. Guidance about potentially appropriate and inappropriate sites for the use of

roundabouts is available. The site-specific conditions are to be compared to those in the table to
determine whether a roundabout merits further consideration.

Stage 2: Operational Feasibility.

Once a roundabout is determined to be a potentially appropriate form of traffic control, the
second stage involves testing to determine if a roundabout can function at an acceptable level of
service. A capacity analysis is performed to determine volume-to-capacity (v/c) ratio and basic
lane needs. This analysis is based on peak-hour volumes appropriate for local conditions. The
analysis is conducted for both Construction Year and Design Year traffic volumes.

Stage 3: Comparative Performance.

Once it is determined a roundabout can function at an acceptable level of service, the final stage
compares it’s performance to the performance of other potential forms of traffic control (such as
signalization) at the given location. The comparison may include, but should not necessarily be
limited to: operational performance, construction cost, life-cycle cost, right of way
considerations, “reserve capacity” (the ability to accommodate traffic growth), and
constructability.

The justification procedure for each roundabout will be documented in a memorandum
describing the results of the analysis described performed in the three stages. This memorandum
will also summarize the reasons a roundabout was selected as the method of traffic control. The
memorandum will be included in the projects conceptual report.
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233.3.1.2 Operational/capacity analysis

The capacity model described in the Highway Capacity Manual (HCM) will be used as the
primary check of a roundabout’s capacity. The HCM model applies only to single-lane
roundabouts. The model is fundamentally based on gap-acceptance theory. Capacity values are
developed for each approach based on peak-hour circulating volumes. Roundabouts will be
designed to operate at no more than 85% of capacity. This concept is known as “practical
capacity.”

Additional analysis is performed to refine the geometric design and provide more information for
Stage 1 and 2 of the justification procedure. Operational analysis will use the SIDRA software
package. If simulation is desired, the VISSIM software package will be used.
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Terminology for Single Lane Roundabout

233.3.1.3 Design criteria

Three fundamental considerations in roundabout design are design speed, capacity, and design
vehicle. These parameters result in a series of tradeoffs; while large-diameter roundabouts may
provide higher capacity and better truck accommodation, they tend to reduce safety through
higher operating speeds. Typical dimensions for a standard four-leg roundabout that satisfies
fundamental design criteria are available.

A maximum operating speed of 25 mph should be used. A typical range of 18 to 22 mph is
desirable. Speed control at roundabouts is primarily achieved through the deflection of entering
vehicles. Operating speeds should be calculated on a move-by-move basis, by drawing the
fastest path allowed by the roundabout geometry. The designer develops a speed matrix to
illustrate that all speeds have been checked and that operating speeds do not exceed the
maximum.

The design of all roundabouts will accommodate a WB-67 design vehicle. In order to keep
operating speeds below the allowable maximum, a truck apron may be provided.

Emergency vehicles can generally be accommodated at roundabouts that have been designed for
WB-67 design vehicles. Turning paths are checked using AutoTurn software for all allowed
movements from each approach, to verify the design vehicle and emergency vehicles can be
accommodated.

Transit stops are not to be placed within roundabouts. Transit stops located near roundabouts will
include bus turnouts to promote traffic flow and increase safety.

233.3.1.4 Sight Distance

Two categories of sight distance are examined at roundabouts; stopping sight distance and
intersection sight distance.

At a minimum, three types of stopping sight distance are checked; approach, circulatory and
exit/pedestrian. Methods to measure these values are available. Sight distances are based on a
driver eye height of 3.5 ft. and an object height of 2.0 ft.

Two types of intersection sight distance are measured; adjacent entry and circulatory. Methods
used to measure these values are also available. Sight distances are based on a driver eye height
of 3.5 ft. and an object height of 3.5 ft.
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233.3.1.5 Central Island

The central island will be separated from the truck apron by a 6 in. barrier curb. The central
island is typically circular in shape. In certain situations, non-circular shapes such as ovals or
ellipses can be used. These shapes can be justified for use if irregular approach geometry or an
odd number of approaching roadways are at the site. The design of the central island is governed
by the operating speed and the design vehicle for the roundabout.

233.3.1.6 Truck Apron

A truck apron is a raised mountable portion of the central island that provides additional
circulatory width for large vehicles. A truck apron is to be provided when the central island
geometry, as designed to maintain low circulatory speeds, impedes circulation of the design
vehicle.

The truck apron is separated from the circulatory roadway by a three-inch mountable curb. The
width of the truck apron is the minimum necessary to accommodate the design vehicle. An
overly wide apron can confuse drivers by creating a distorted sense of proportion. The width of a
typical truck apron is 10 ft.

The truck apron will visually contrast with the circulating roadway. This will delineate the truck
apron and discourage motorists from driving on it.

233.3.1.7 Circular Roadway

The width of the circulatory roadway will be the minimum necessary to accommodate the design
vehicle. It is equal to the difference between the inscribed circle radius and the central

island/truck apron radius. Parking or stopping in the circulatory roadway is prohibited. The outer
edge of the circulatory roadway will be a barrier curb (except at openings for entry and exit legs).

233.3.1.8 Splitter Islands
. . .-‘_3 _"

3 F iy

Splitter islands serve two primary functions at a roundabout; physical separation of entering and
exiting traffic (consequently reinforcing one-way circulation), and deflection of entering traffic
(to control entering speeds). In addition, a splitter island can serve as a pedestrian refuge.
Splitter islands will include a barrier curb.

The splitter island geometry is typically asymmetrical. Generally, the entry side provides
deflection to slow speeds, while the exit side provides a larger opening to facilitate egress.

The minimum width of a splitter island without a pedestrian crossing is 4 ft.; with a pedestrian
crossing, the minimum width (at the crossing) is 6 ft. The pedestrian opening will be 10 ft.
wide.
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233.3.1.9 Approach Roadway

On approach roadways with a wide median or a two-way left-turn lane (TWLTL), a narrowing of
the existing median, to match the splitter island dimensions discussed above, will generally be
needed in order to achieve the necessary entry deflection.

Approach roadway legs will include a barrier curb (on the right side) for at least half the length
of the splitter island. A typical entry width is 16 ft. (measured curbface to curbface) to allow
traffic to bypass a stalled vehicle. The turning path of the design vehicle controls the exit width.
A typical exit width is 18 ft.

233.3.1.10 Bypass Lanes

Right-turn “bypass lanes”, channelized so vehicles do not enter the roundabout, may be
considered on approach roadway legs. Bypass lanes are to be avoided where moderate to high
pedestrian or bicycle volumes are anticipated. Pedestrian crossings are discouraged across bypass
lanes. Potential applications for which bypass lanes are to be considered (this list is not
exhaustive) are:

To reduce the number of vehicles entering the roundabout

If right turns compose more than half of the entry volume, or

If the right-turn volume exceeds 300 vehicles during a single hour

To resolve geometric difficulties

An approach with two existing lanes intersecting a roundabout at which only one circulating lane
iS needed

An acute angle between adjacent legs

The use of a bypass lane must account for potential weaving and merging needs of traffic. The
presence of closely spaced intersections, nearby driveways, and “entrapment” lanes can
negatively affect bypass lane operations. These concerns must be thoroughly examined before a
bypass lane is included as part of a roundabout.
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233.3.1.11 Bicycles and Pedestrians

Bicycle facilities or markings are not provided within the circulating roadway or the central
island. If bike lanes are provided on the intersecting roadways, they should be transitioned to off-
street facilities sufficiently in advance of the roundabout to avoid introducing additional driver
decision points in the roundabout. Bicyclists may choose to enter the roundabout as a vehicle
(using the circulatory roadway) or, they may use multi-use facilities if they are provided.
Potential bicycle-lane treatments, including bicycle ramps and bicycle platforms are
available.

The design of a roundabout will not encourage pedestrian movement within the circulatory
roadway or the central island. If crosswalks are determined to be necessary, they are typically
located approximately one vehicle length behind the yield line (to allow a pedestrian to cross
behind a stopped vehicle), unless it is determined a larger distance is needed to prevent exit
gueues from backing into the circulatory roadway. Even if sidewalks are not provided, curb cuts
and splitter island openings will still be provided at the typical locations in anticipation of future
crosswalks. In all cases, pedestrian-related design will conform to the requirements of the
Americans with Disabilities Act (ADA).

233.3.1.12 Other Issues

Dropping a lane approaching a roundabout is not typical within a distance less than 200 ft., as
measured from the downstream end of the lane drop taper.

Ideally, the angles between all adjacent roundabout legs are equal (for example, 90° on a 4-leg
roundabout). Maximizing the spacing between legs promotes smooth traffic flow. The designer
should attempt to space the approaches so the distance between the extended centerlines of
the entry lanes of any two adjacent approaches, measured along the centerline of the circulatory
roadwayi, is at least 50 ft. If reasonable spacing cannot be achieved, careful design consideration
is needed to optimize operational characteristics.

Ideally, roundabouts are constructed at level intersections. The maximum approach grade to
roundabout is 3%.

It is desirable to provide a -2% cross slope (away from the central island) on the circulatory
roadway. A -4% (away from the central island) cross slope on the truck apron is preferred.
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233.3.1.13 Signing and Pavement Marking

Typical signing and pavement marking for a roundabout are available. There are three
classes of signs that are used in a roundabout. They are:

Requlatory

Warning

Guide

Pavement markings are provided in three areas of the roundabout. They are:
Circulatory roadway

Approach legs

Pedestrian crossings

Specific signing and pavement marking details are also available.

233.3.1.14 Landscaping, Lighting and Drainage

Any landscaping of the roundabout will be located so it does not obstruct sight distance.
However, it is generally a good idea to locate landscaping in the center of the central island to
create a visible, vertical obstruction that can be seen well in advance. This has the added effect of
blocking views between opposing approaches. Landscaping will not attract pedestrians to the
center of the roundabout — in fact, low landscaping can be used on the outside of the roundabout
(between the sidewalk and the curb) to provide a physical barrier to direct pedestrians toward the
crosswalks. The splitter islands are not to be landscaped. Landscaping will not introduce any
hazards to the intersection.
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Fig. 233.3.14 Conflict points of signalized intersection (left) and roundabout (right)
Landscaping will be designed for minimal maintenance. If vegetation within the roundabout
requires watering, a sprinkler system will be installed.

Lighting intensities at roundabouts will generally conform to MoDOT guidelines for intersection
lighting. Key locations to be lit include the splitter island approach noses, all conflict areas where
traffic enters the roundabout, and all places where vehicles exit the roundabout. The roundabout
will be lit from the outside towards the center. If a 30 ft. luminaire height is used, 8 luminaries
are recommended. If a 45 ft. height is used, 4 luminaries are recommended.

Drainage for the roundabout and approach legs will follow MoDOT design criteria. Additional
consideration must be given to drainage of the central island.

233.3.1.15 Traffic Control During Construction

The designer must consider the implications of the roundabout’s construction on local traffic
flow. An initial constructability check, including staging and interim traffic control concepts, is
necessary. In accordance with MoDOT policy, the designer will attempt to minimize detours
during construction, while maximizing safety and minimizing motorist confusion. Nighttime and
off-peak construction activities are encouraged. If the roundabout location is to be “bypassed”
during construction, design speeds for the temporary bypass will be similar to those of the
completed roundabout, so there is no perceived loss of level of service.
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233.3.2 Multi-lane Roundabouts

A multi-lane roundabout is a roundabout with more than one lane on any portion of the
circulatory roadway. Unless otherwise specified herein, the guidelines for single-lane
roundabouts also apply to multi-lane roundabouts.

One of the most important considerations in multi-lane roundabout design is driver
understanding. Every facet of the design must be oriented toward conveying the safe and proper
method of driving the roundabout. At a typical two-lane roundabout, the driving rules are:

If you plan to exit less than halfway around, enter the roundabout using the outside lane

If you plan to exit more than halfway around, enter the roundabout using the inside lane

If you plan to exit halfway around, you can enter using either lane

Permitted maneuvers at a typical two-lane roundabout are available. In certain cases
deviations from these rules may be necessary. In all cases, expectations must be clearly conveyed
to drivers.

In planning roundaboults, it is advisable to consider the differences between short- and long-term
needs. If a single-lane roundabout will suffice in the near-term, but a multi-lane roundabout will
be needed in the future, the designer will consider constructing a single-lane roundabout with
accommaodations for a relatively simple conversion to a multi-lane configuration in the future.
Examples of such accommodations might include wider splitter islands or a larger initial central
island diameter. Particular attention must be paid to the amount of construction necessary to
convert a one-lane roundabout to a two-lane configuration, and to the traffic control that would
be necessary during such construction. The minimization of operating speeds will continue to be
a key design objective.

In all cases, thorough conceptual planning must be completed before design begins. This
includes detailed analysis, geometric feasibility assessments, and consideration of user
characteristics.

233.3.2.1 Justification for Use

In general, the justification procedures used for single lane roundabouts are also used to justify
multi-lane roundabouts. Only the volume-related justifications change: Multi-lane roundabouts
may be considered appropriate for intersections with design-year entering peak-hour volumes
typically not exceeding 3,700 vehicles (certain treatments, such as bypass lanes, could allow the
accommodation of higher volumes.)

For multi-lane roundabouts, the justification process must also consider the nature of motorists in
the area of the proposed roundabout (e.g. tourists, trucks, buses, senior drivers).

Multi-lane roundabouts present more complex design issues than those of single-lane
roundabouts. They also present a more complex set of decisions to drivers. In recognition of
these facts, roundabouts must be designed to minimize the number of circulating lanes to the
extent that is operationally feasible. In other words, single-lane circulating roadways are
preferred over multi-lane. The most significant point of confusion at a multi-lane roundabout is
at the exit, where it may not be clear to motorists who may continue circulating and who may
not. Single-lane exits reduce this confusion.
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With the above concept in mind, it will often be desirable to consider roundabouts on which only
a portion of the circulatory roadway carries multiple lanes. Such roundabouts can be subdivided
into two categories:

Instances where an additional “turning” lane is added within the roundabout to facilitate a heavy
movement, and

Instances when additional “through” capacity is carried through the roundabout on one street but
not another (sometimes referred to as a “2-lane/1-lane” configuration).

Examples from both these categories of partial multi-lane roundabouts are available.

At freeway interchanges with one-way ramps (such as diamond interchanges), the teardrop
configuration, which prevents circulating movement in front of one approach, may be used.
Although one approach will not be required to yield to circulating traffic, that approach must still
be designed to slow entering traffic to the required operating speed. The designer will verify that
the elimination of U-turn movements on the teardrop leg will not result in access problems on
nearby roadways.

Roundabout dimensions are a function of operating speed and the design vehicle. The
roundabout must be large enough to accommodate the design vehicle, but not so large as to
encourage excessive speeds. These two parameters are the guiding elements in choosing
roundabout dimensions; however, the following dimensions can be used as a general guide. In
urban settings, the inscribed circle diameter for a four-leg two-lane roundabout typically
ranges from 150 to 180 ft. In rural settings, the inscribed diameter typically ranges from 180 to
200 ft.

Multi-lane roundabouts with more than four legs are extremely complex from a driver’s point of
view. They present unique challenges in signing and pavement marking. Wherever possible,
the use of partial multi-lane configurations is encouraged with roundabouts having five or more
legs.

Roundabouts with more than two circulating lanes are discouraged on Missouri state highways,
and will be considered a design exception.

233.3.2.2 Capacity Considerations

Many of the operational and capacity considerations of single lane roundabouts also apply to
multi-lane roundabouts. However, the Highway Capacity Manual (HCM) does not currently
address multi-lane roundabouts, so the SIDRA and VISSIM software packages will be the
primary analysis tools. The “practical capacity” used in designing each approach to a multi-lane
roundabout will be 75% of the estimated approach capacity. The designer will ensure that the
lane-usage assumptions of the analysis are consistent with the proposed operation of the
roundaboult.

233.3.2.3 Signals

Traffic signals will not be allowed within, or at any exit/entry point of, a roundabouts on
MoDOT roadways.

A typical spacing distance between roundabouts and adjacent signalized intersections has not
been determined. Instead, the designer must ensure, through operational analysis, adequate
distance is available to accommodate 95th-percentile queue lengths between a roundabout and an
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adjacent intersection. This includes queues approaching the roundabout as well as queues
approaching the adjacent intersection.

233.3.2.4 Operating Speed

A preferred operating speed of 30 mph will be used for multi-lane roundabouts. A typical range
of 23 to 27 mph is desirable.

233.3.2.5 Vehicle Path Overlap

Design vehicle requirements for single lane roundabouts also apply to multi-lane roundabouts,
with one addition. The designer needs to consider the circulating paths of large vehicles entering
the roundabout. At smaller two-lane roundabouts, operators of large vehicles may find it
necessary to straddle both circulating lanes. At larger roundabouts, large vehicles may be able to
maintain a constant lane. The choice between these two options will affect how turning templates
are checked.

For roundabouts where trucks are likely to straddle the circulating lanes, a truck apron is
typically not necessary. At roundabouts designed to accommodate two circulating trucks side-by-
side, a truck apron may be necessary to keep the circulatory roadway width to a minimum.

It is necessary to avoid “vehicle path overlap” wherever possible during the design of multi-lane
roundabouts. On entry, vehicle path overlap most commonly occurs when an entering motorist in
the outside lane finds it natural to “drift” toward the inside lane when entering the roundabout.
One potential method to discourage vehicle path overlap on entry is to design the entry flare so a
tangent can be drawn between the entry lane line and the circulating lane line.

At two-lane roundabout exits, it is necessary to pay attention to lane width and exit radius in
order to discourage vehicle path overlap. Vehicle path overlap can occur if the exit radius is so
small motorists in the inside lane will tend to “drift” into the outside lane when exiting. A
potential method to check for exit overlap is to draw (on a scaled plan) the smoothest continuous
connection between the centerline of the circulatory roadway and the centerline of the exiting
lanes. If the radius of this connection is less than the radius of the centerline of the circulatory
roadway (implying a lower design speed), vehicle path overlap may result. The exit radius and
width may need to be adjusted. As with entry path overlap, the exit geometry design is a tradeoff
between keeping speeds low enough to maximize pedestrian safety and keeping radii large
enough to avoid vehicle path overlap. In cases where path overlap and design speed conflict,
minimization of design speeds receives a higher priority.

Although eliminating vehicle path overlap is an important goal, the designer must
simultaneously take care to avoid promoting excessive entry speeds. In cases where path overlap
and design speed conflict, minimization of design speeds receives a higher priority.

At larger roundabouts, the solutions described above may result in either an excessively sharp
entry flare or an excessively wide splitter island. Therefore, it may be difficult to avoid vehicle
path overlap.

233.3.2.6 Bypass Lanes

Bypass lanes are a potential method for addressing heavy right-turn movements. A less preferred
(due to lower capacity) but acceptable method is to include a dedicated right-turn lane that is not
physically separated from the roundabout. If this method is used, the circulatory roadway in that
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quadrant of the roundabout will be widened to allow the right-turning vehicles to enter the
roundabout simultaneously with adjacent through vehicles on the same approach. This
configuration is potentially more confusing than a typical bypass lane configuration, and is only
used where necessitated by right-of-way or other physical constraints. Adequate signing and
marking must accompany this configuration.

To minimize motorist confusion, single-lane exits are to be considered wherever operationally
feasible.

Typically, it is not desirable to require motorists to merge immediately after exiting a two-lane
roundabout (via a lane drop). However, in some cases, having two departure lanes may be
desirable for roundabout processing capacity, while the basic underlying roadway may only
carry one lane per direction. If a lane drop (reduction) is necessary, it will occur a minimum of
200 ft. from the roundabout exit, with a standard merge taper.

233.3.2.7 Signing and Pavement Marking

All the provisions of single lane roundabouts also apply to multi-lane roundabouts, but additional
signing is necessary to convey lane usage. The preferred signing method, which uses
overhead signage to delineate lane use, is available (also refer to Highway Signing). However,
each site must be evaluated on its own merits to determine signage needs. In general, signing for
a proposed roundabout will be thoroughly considered at the concept stage, because the
effectiveness of a roundabout, even one with excellent geometric design, can be compromised if
drivers do not understand how to drive it.

All the provisions used for single lane roundabouts also apply to multi-lane roundabouts, but
additional markings are needed to help delineate the circulatory lanes. Typical pavement
markings for a multi-lane roundabout are shown in Pavement Marking. Standard Plan
620.00 illustrates standard pavement arrows and placement.

The function of circulatory lane striping is to reinforce permitted movements circulating and
exiting the roundabout. In cases of odd geometry or more than four legs, customized
modifications to the typical striping pattern may be necessary.

Pavement arrows within the circulatory roadway are not typically used.

Where multiple lanes enter a roundabout, a solid white line will separate the lanes on the
approaches. If this line is a continuation of an existing intermittent lane-striping pattern, the
conversion to the solid line will occur a minimum of 100 ft. in advance of the yield line.
Similarly, multiple lanes exiting a roundabout will be separated by a solid white line, which will
remain solid for a minimum of 100 ft. beyond the roundabout exit.

At conventional multi-lane roundabouts with three or four legs, lane-use arrow markings
(supplemented by appropriate signage) may be used on the approaches. If arrows are used, one
set of arrows should be located near the yield line, and another set will be located in advance.
All of the pedestrian considerations described for single lane roundabouts also apply to
multi-lane roundabouts. However, due to wider approaches and exits, multi-lane roundabouts
result in more pedestrian exposure than do single-lane roundabouts. Special care is necessary to
maximize pedestrian safety at multi-lane roundabouts. This could include special treatments such
as decorative crosswalks, raised crosswalks (which have the added effect of reducing vehicle
speeds), or alternative crosswalk locations (further away from the roundabout) that maximize
pedestrian visibility and comfort.
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233.3.2.8 Other Issues

In general, while the provisions for single lane roundabouts also apply to multi-lane roundabouts,
it may be necessary in certain instances to crown the circulating roadway. One advantage of this
approach is it can promote consistency in speeds by superelevating the tighter-radius inner lane
and negatively superelevating the higher-radius outer lane. The drainage design becomes more
complex since inlets and/or slotted drains will be needed on both the inside and outside edges of
the circulatory roadway.

The key lighting locations provided for single lane roundabouts also apply to multi-lane
roundabouts: the splitter island approach noses, all conflict areas where traffic enters the
roundabout, and all places where vehicles exit the roundabout. At larger roundabouts, the
general lighting layout guidelines of may be inadequate; therefore, the designer must check
lighting levels to verify adequacy.

Because of the complexity presented to drivers by multi-lane roundabouts, some form of public
education program must be considered with each installation especially when multi-lane
roundabouts are new to a given area. Safety is increased when motorists are aware of the proper
method of driving a multi-lane roundabout.

233.3.3 Deflection

Alignment Offset Left Radial Alignment Alignment Offset Right

PREFERRED ACCEPTABLE

Note Avoid the offset right alignment

Adequate deflection, a horizontal curve in the road that slows approaching traffic, is critical to a
proper roundabout design. One of the easiest ways to achieve deflection is to incorporate a left

104



_ [ROUNDABOUT WORKSHOP]

offset in the design by aiming the approaching road’s centerline to the left of the central island’s
center.

The maximum operating speed should be 25 mph. Bear in mind that drivers often go faster than
the models predict. Also, be aware that trucks can experience resonance in a reverse curve.
Depending on speed, vehicular shape and distribution of load, it is possible for trucks to roll over
at speeds as low as 20 mph.

Whether or not a left offset is selected, the designer should be careful to place the pedestrian
crosswalk, if one is present, after the deflection — not in the deflection - so that the traffic is
proceeding as slowly as possible when it encounters the crosswalk.

W

Constructing the roundabout's apron
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